
Configuration

Shopware provides multiple different configurations to change and alter your shop so it matches your exact
wishes and needs.

In this area of the documentation we deal with those configurations and options.

Additionally it is described, how to create different elements like products, marketing options, shopping
experiences and many more.



Catalogues

Catalogues are the central area for managing your products and other related data such as properties,
manufacturers and categories.
You can also create dynamic product groups here.

Product overview

Under Catalogues > Products you will get a list of your created products with the most important
information. By clicking on the respective column header, you can change the sorting of the products.
Next to the individual column captions you will find a button which you can use to hide the column.

In the overview (1) you can find the most important information about your products at a glance.
The standard overview is structured as follows:

Active: Indicates whether the item is active and can be used in the shop.

Name: The name of the product, which is used as a heading on the product detail page,
for example.

Product number: The unique product number.

Price: Displays the price for the default customer group.

In stock: Displays the current stock, plus colored information. (0 = red; 1 - 25 = yellow,
>25 = green)

Manufacturer: Name of the product manufacturer



Using the context menu (3) on the right side you can edit, duplicate or delete the product. For variant
products, you can also access the variant settings directly here.
To the right of the overview, you will also find the option to update the product overview or to narrow it
down further using filter settings (4). 

You can also see directly whether a product contains variants. This is indicated by an additional symbol
(2) before the name. If you click on the symbol, a modal overview with the variants opens.

In this overview, the essential information of the variants is displayed. In the column Name you can see the
properties from which the variant was generated. In addition, price, stock, active and product number are
listed.
In addition, entries can be edited directly in the overview, simply double-click on the desired variant. If you
want to make further adjustments to the variants, you can call up the extended editing mode using the "..."
menu (1).  You can open the main product to make changes by using the link (2) below the overview.

List settings

In the header line, you will find a button on the right side to adjust the list settings.

Here you can (de-)activate the compact mode. This removes the larger line spacing and more lines can be
displayed without scrolling. You can also hide and show columns here, and set the order of the columns
using the two buttons to the right of each column.



Context menu

On the right side, you can use the button "..." to open the context menu for the respective product and get
access to further functions.

Edit: Click here to open the processing mask of the product. You can find further
information on the individual functions of all fields in the article Add a new product.

Duplicate: With this option, you can copy a complete product. So you can quickly create
several similar products. You can go directly to the edit mask of the product to make
changes. By default, the new product is created with the next higher product number
and the word copy after the name.

Delete: If you no longer need the product, you can delete it by clicking here.

Please note that products that are already included in orders will continue to be listed as items in the order
even after the product is deleted, but will refer to a non-existent dataset. Therefore, we recommend not to
delete such products, but to deactivate them.

Bulk edit

Bulk edit offers you an easy and quick way to change multiple products at the same time.

You can select individual products (1) or all products that are displayed on this page (2). You also have
the option to select products on multiple pages. The maximum products that can be selected at once are
1000. The number of currently selected products (3) is displayed above the products. The option to
deselect all products (4) is only shown if you have selected products from multiple pages. To edit the
selected products click bulk edit (5), to delete all selected products click delete (6).

After clicking bulk edit, a pop-up window appears, showing you the selected variants.

https://docs.shopware.com/en/shopware-6-en/catalogues/add-product


In this overview, you have the option to remove products from your current selection. Once you are
satisfied with your selection, click start bulk edit.

Mark the checkbox (1) of the information you wish to change, update the values (2). Click save (3) to
proceed.
Please note that only values for which the checkbox is ticked will be changed.

It is not possible to set the cover image by multiple change.
Updating the gross price does not change the net price.

The information to be edited is divided into blocks, such as properties or assignment, similar to the product
configuration of a single variant. In some blocks, where it is reasonable, you have an additional dropdown
with different options. This option decides how the changes within this block are to be handled.



Overwrite: If you select this option, the previous information will be overwritten by the
now selected information.

Clear: This option removes all settings and information from this block.

Add: With this option, only the selected settings are added to the variants. Existing
settings will not be removed.

Remove: This option removes the selected settings from the variants, if they existed in
the variants. 

A popup will show you the number of items that are about to be changed, confirm this by clicking apply
changes.



Please wait while the system is updating the product information.

Shopware will notify you once the task is complete. Click close to exit and return to the overview.

Want to dive deeper?
You’ll find an interactive learning path on this topic in the Community Hub. Explore it step by step, try out
features directly, and grow your knowledge in a playful, hands-on way. 

Prices & Advanced Prices

https://hub.shopware.com/learn/unit/bulk-product-management


In the Prices block, you can define basic price-relevant configurations for multiple products simultaneously
using the bulk edit function.
 

Tax rate: Select the tax rate for the products here.

Price (gross): Enter the gross price including VAT.

Price (net): Enter the net price without taxes.

List price (gross): You can display the RRP in the frontend using the list price, for
example. For the display to take place, the list price must be higher than the price of the
product.

List price (net): You can also add a net list price.

Purchase price (gross): You can enter your purchase price. But this price has only
informative character. If the purchase price is entered, this can be taken into account in
the evaluations (separate extension).

Purchase price (net): In addition, you can also enter a net purchase price.

Cheapest price (last 30 days) (gross): Here you can enter the cheapest price (gross)
of the last 30 days.

Cheapest price (last 30 days) (net): Here you can enter the cheapest price (net) of
the last 30 days.

 



In the Advanced Pricing block, you have the option of adding price details such as scaled prices or
deviating prices according to certain conditions. You must first define how the changes to this block are to
be handled using the options in the dropdown. (Overwrite, Clear, Add or Remove). If you then click on
Create new advanced prices, a modal will open.

After you have selected a condition rule, another modal opens.
 

In addition to the options to set scales and define prices, list prices and currency-dependent prices (gross
and net), you also have the possibility to change the previously selected condition rule using the drop-
down menu (1), delete pricing rules (2) or duplicate pricing rules (3). You can also add further
pricing rules (4) to create scales and prices for additional condition rules. When you have configured
everything according to your preference, you can simply close the modal via the Close button and
continue with the bulk edit.

Manufacturer



You will find an overview of the already created manufacturers here.
In the overview, the most important information about the individual manufacturers is displayed directly.
In addition, you have the possibility to adjust the sorting of the table (ascending and descending) by
clicking on the respective column heading.
 

On the right side of each line, you can use the button "..." to open the context menu for the respective
manufacturer.
This menu offers you further options:

Edit: Opens the editing view for the manufacturer.

Duplicate: Creates a copy of the manufacturer with the stored data.

Delete: Click here to delete the manufacturer. Note, however, that the manufacturer
can only be deleted if it is not assigned to any product.

Add a new manufacturer

You can add a new manufacturer via "Add manufacturer".
Clicking the button opens the corresponding mask for adding a new vendor.
 



The only mandatory information required for creating a manufacturer is the name.

In addition, you can link to the website and store the company logo.
It is also possible to add a description text to the manufacturer's page, providing customers with additional
information about the manufacturer.

The description can also be output via Twig variables in the storefront. You can find more information on
this in this article.

Manufacturer search in the storefront

If you have created one or more manufacturers in the admin and maintained them with the corresponding
information, you can see them in the top right-hand corner of the product detail page for the products for
which you have entered a manufacturer. There, you can see the name of the manufacturer, or alternatively
the logo, provided you have uploaded this to the manufacturer in the admin.
If the manufacturer has a website (link), the name or logo can be clicked on the product detail page.

Create a manufacturer page

There is no manufacturer page, as in Shopware 5, in the classic sense. However, an alternative way to
realise this is as follows.

https://docs.shopware.com/de/shopware-6-de/tutorials-und-faq/aenderungen-am-template-vornehmen


First, a landing page is required in the experience worlds, which can be created as desired. You can find
more information on this in this article.

In order to be able to use the created experience world, a landing page is now created under Catalogues
> Categories. You can find more information on this in this article.

In the landing page, the corresponding mandatory fields must be filled in, especially for the SEO URL, note
that this will be the URL under which the manufacturer's page can be reached. In the example,
shopwareag is entered as the SEO URL. Preview: https://www.dein-shop.de/shopwareag

The previously created experience world for the manufacturer is then added in the second Layout tab.

Once the framework is in place, the previously defined SEO URL must be saved as a website for the desired
manufacturer under Catalogues > Manufacturers. It is important to put a slash in front of it. Example:
/shopwareag

https://docs.shopware.com/en/shopware-6-en/content/ShoppingExperiences#landingpage
https://docs.shopware.com/en/shopware-6-en/catalogues/categories#seo-1


Want to dive deeper?
You’ll find an interactive learning path on this topic in the Community Hub. Explore it step by step, try out
features directly, and grow your knowledge in a playful, hands-on way. 

Create products

The mask for creating a new product is thematically divided into different areas.
In this article you will learn everything about how to create a new product and what you should think about.

Please note that some features are only available after you have saved the product for the first time.

The following fields are required to be populated prior to saving:

Title

Product number

https://hub.shopware.com/learn/unit/user-manufacturers


Tax rate

Price (gross and net)

Stock

View after saving

After the product has been saved with the required mandatory information, the other options
Specifications (1), Extended Prices (2), Variants (3), Layout (4), SEO (5) and Cross Selling (6) are
available and can be called up through the upper navigation tabs. Using the arrow navigation (7), you
can scroll through the area navigation and thus reach areas that are not directly visible, such as ratings.

Learning path available
You’ll find an interactive learning path on this topic in the Community Hub. Explore it step by step, try out
features directly, and grow your knowledge in a playful, hands-on way.

General

General information

https://hub.shopware.com/learn/unit/user-first-product


Title
You can e.g. enter the product name. This name will be displayed among others in the product listing and
used as a heading on the product detail page.

Manufacturer
Here you can choose one of the already stored manufacturers from the list.
If the desired manufacturer is not listed here, you can add it under Catalogues > Manufacturer > Add
manufacturer.

In parallel, it is also possible to create the manufacturer directly when you creating a product. This saves
you one step and you don't have to jump not have to jump back and forth between different menu items.

Productnumber
Here you have the possibility to assign an individual product number to your product.
As a rule, this is done automatically according to your number ranges.

Description
In the description you have the possibility to offer the customer an overview of the product.
The data stored here is displayed on the product detail page, for example.

In the module you also have the possibility to edit the description via WYSIWYG editor (1).

If you paste copied text into the editor using Copy & Paste, the formatting is automatically applied. To get
around this, you can use the shortcut Ctrl + Shift + V to paste the copied text without formatting it. For
MacOS, the keyboard shortcut is Command + Shift + V.



You can link an internal SEO url, for example of a category or a product.

You can do this using the magic placeholder "124c71d524604ccbad6042edce3ac799" and the UUID of
the product, category, etc. (1).
The url is then automatically converted in the storefront.

Product promotion
This can be used to provide the product with a badge in the listing, for example, so that it is displayed more
conspicuously for customers.

AI description assistant

With the description assistant you can create a text suggestion for the product description with the help of
an artificial intelligence.

This feature is available to you from a booked Rise plan.

You will find the description assistant below the product description (1). By clicking on it you will get to the
description assistant.

https://docs.shopware.com/de/shopware-6-en/features/shopware-rise


In the assistant you will first find important information about legal conformity, validity and completeness.
To generate a text, the AI must first be fed with data.

To do this, enter Key information (1) on the basis of which the AI generates a text. You can enter
keywords, such as special features that match the product, as terms. The terms are separated by a comma
or a space. As soon as you have entered the desired key information, you can click on Generate (1). The
AI will now generate a formulated text that contains your key information (3). You can then copy the
finished text proposal for further use (4).



Be aware that the AI feature is an assistant. The generated text is only a suggestion and does not claim to
be error-free and 100% (legal) complete. You should check all generated texts for legal compliance, validity
and completeness.

Prices

Here you can define basic information and set a standard price.
You can add further price details like e.g. scaled prices or deviating prices according to certain conditions
under Advanced pricing.

Tax rate
If you create new products, the standard tax rate is automatically stored here as a preselection. Adjust the
applicable tax rate. One standard tax rate and up to two reduced tax rates are predefined for most
countries. You can see the exact tax rates in the settings. There you can also adjust the pre-filled tax rates
for this input field or tax rates in general, create additional ones and assign countries.
Within the customer groups, you can define if the prices are calculated gross or net. If it is set to net, the
taxes are calculated in the order.

Price (gross)
Enter the gross price incl. the VAT.

Price (net)
Enter the net price without taxes.

Purchase price (gross)
If the purchase price is stored, this can be taken into account in the evaluations.

Purchase price (net)
You can also enter the net purchase price.

List price (gross)
You can display the RRP in the frontend via the list price, for example.
For the display to take place, it is necessary that the list price is higher than the price of the product.

https://docs.shopware.com/en/shopware-6-en/settings/taxes
https://docs.shopware.com/en/shopware-6-en/settings/customergroups


List price (net)
In addition to the gross list price, you can also maintain the net list price.

The gross and net prices can be linked with the lock symbol.
When locked, if you chance one price, the other price is automatically calculated using the stored tax rate.

Cheapest price (last 30 days, gross)
You must fill in this field if you want to advertise price reductions in your store in the EU. Such information
should be verifiable by customers in the EU. Therefore, in the case of price reductions, in addition to the
price reduction on the current price, the lowest price of the goods in the last 30 days before the price
reduction must also be indicated. This is prescribed in Art. 6 a of Directive 98/6/EC.

Cheapest price (last 30 days, net)
You can also enter the cheapest net price for the last 30 days.

Curreny dependent pricing

With the currency dependent prices you have the possibility to store your own prices for the individual
currencies. In the standard system, the prices for the currency are linked to the standard price and are
automatically converted using the stored factor. If you want to maintain your own prices for the currencies,
you can remove the link by clicking on the chain symbol for the respective currency. Then you can fill in the
fields for price, list price and cheapest price for the last 30 days.

Deliverability



Stock
The stock level is adjusted in real time in the event of changes. For example, if an order is received, the
value is reduced.

Available stock
The field mirrors the current stock, so both values are always the same.

Before Shopware 6.6.0.0 a different stock management was used. If you are using an older version, select
your version at the top right so that you get the appropriate article.

As soon as a customer wants to add a product to the cart for which the clearance sale option is activated,
Shopware checks the stock level. When an order is placed, the stock level is reduced. As soon as the order
is received, the number of sales for the purchased product increases. You will find the corresponding
column in the product or variant overview.

If desired, this stock calculation logic can be disabled: Disable stock calculation

When the customer completes the order, it is deducted from the available stock, but the stock remains.
After changing the order status to completed, the order is deducted from the stock.

On the other hand, if the order is cancelled, it is added back to the stock.

Clearance sale
If an product is marked as clearance sale here, it cannot be sold beyond the available stock.

Delivery time
In the delivery time you indicate, how long it approximately takes for the product to reach the customer.
If a delivery time is defined in the product, it overwrites the delivery time of a shipping method.

Restock time in days
The restock time in days indicates how long it will take until a sold out item is back in stock. For items not
in stock, this time is added to the delivery time.

Free shipping
If checked, the product will be shipped free of charge. That means, that the product is free of shipping
costs on its own and does not affect any shipping calculations that may follow.

Min. order quantity
The product can't be placed in the shopping cart if the minimum order quantity is not reached.

Purchase steps
Here you can specify the scales in which the item is to be offered.
For example, a scale of 2 means that your customers can purchase 2, 4, 6 products, etc., but not 1, 3 or 5.

https://docs.shopware.com/en/shopware-6-en/tutorials-and-faq/howto/disable-stock-calculation


Max. order quantity
Set a maximum order quantity for a product. This will limit the amount a customer can order of the given
product per order.

Warehouses and warehouse groups

This function is available with version 6.4.19.0 in combination with the Beyond Plan.

If warehouses are defined in the settings, you can choose them in the dropdown-list Warehouse groups
(1).

As soon as a warehouse group (1) has been selected and the product has been saved, the previous fields
for the stocks are hidden, and the link Show availability and delivery time by warehouse and
warehouse groups (2) appears in order to configure the availability and delivery times.

If you click on the link, you will be taken to a detailed screen which allows you to enter the stock levels by
warehouse.

https://docs.shopware.com/en/shopware-6-en/settings/shop/warehouses


The warehouse groups (1) are displayed in the left-hand column. If there are several warehouse groups,
you can choose between them and see the respective warehouses on the right-hand side.

In the Stock (2) column, you can enter the product's stock levels in the respective warehouse. To enter a
value, double-click in the field. The Priority (3) column shows the prioritization of the warehouses within
the warehouse group. The higher the value, the sooner the warehouse stocks are reduced when orders are
placed.

Enter the Stock (1) of the respective warehouse and save it using the button with the hook (2). To
cancel the entry, click on the X button (3).

 
In the Delivery time (1) tab of the pop-up, you can select the delivery time (2) per warehouse group
using the drop-down menu. Here you have the choice between Instant download, 1-3 days, 2-5 days,
1-2 weeks and 3-4 weeks.

Visibility & structure



Sales channel
Here you assign the product to the desired sales channels.
This allows you to determine where the products are available.

Active for all selected sales channels
Here you can define whether the product is displayed in the storefront and can be purchased.

Categories
Assign the product to one or more of the categories here.
In the storefront, the product can then be found in the corresponding categories, e.g. using the category
tree.

Configure extended visibility
In the extended visibility you can configure when exactly this product should be visible in your storefront.
Visible is selected by default, the product will be visible in both the search and the product listing. If you
select hide in listing, the product will be hidden in the product listing. However, you can still find the
product over the search. If you select hide in listing and search, the product is hidden from the product
listing and can't be found by the search. The product can then only be found using the exact URL of the
product.



Tags
The tags allow you to store keywords for your product. These keywords can then be used, for example,
within the rules. If you click in the field, the keywords already stored for other products but also for media
or customers are displayed. To add a new word, you can simply write it in the field and confirm with Enter.

Search keywords
Words that you enter here will be added to the search index of the product. The product can also be found
using these words. Confirm each word entered with the Enter key.

Media

In the Media section you assign the desired media to the product, e.g. product photos.
You can also define which image is to be used as a preview image, e.g. for the product listing.
You can also add new files from your computer or from the Internet ( through the "..." menu).

To ensure a good performance you should not use too large images here. In the Standard Responsive
Theme we recommend using square product images with a resolution of 600x600 for optimal display. In
general, other resolutions are also possible.
If it is important to you that the uploaded images are also zoomed in, we recommend a higher resolution.
As an example you can use the resolution 1920x1920. Please note, however, that loading times can also
increase with a higher resolution.

In addition to product images, you can also add videos to your products using the Media section. The
following common video formats are supported:
webm, mkv, flv, ogv, ogg, avi, mov, wmv, mp4

The MP4 format works most reliably and is supported by all major browsers, making it especially suitable
for cover videos.

Note: The MOV format may not play correctly in some browsers like Chrome, as it is a proprietary Apple
format. However, it works without issues in Safari. For best compatibility, we recommend using videos in
the MP4 format.

3D Models



You can also upload 3D models there. The functions are the same as for conventional media, but a 3D
model cannot be used as a cover for a product or within the shopping experiences. The ThreeJs library was
used for the 3D models.

Only media with the 'glb' format for 3D models are supported.

The 3D model is then displayed in the storefront as a 3D product image, as with conventional media.
Under Content and then Media, you can activate the AR view by clicking on the 3D file using the button of
the same name under Configuration. The size of the product in AR must be defined beforehand, as the size
of the product is not normalized in Shopware. This could otherwise lead to a poor AR experience.

3D files currently are not automatically optimized for storefront rendering and shows there in original
quality and size. We recommend uploading already optimized 3D files to avoid performance damage

A QR code can then be opened by clicking on the 3D symbol at the bottom right of the product image to
open the augmented reality view on a mobile device.



The "Augmented Reality" experience is supported on the following devices: iOS12+, Android 8.0+ with
ARCore 1.9 support.

The function is compatible with the latest versions of most popular browsers, but performance or
compatibility may be affected with older versions.

Labelling

Release date
You can use the release date to define when a product can be purchased in the shop.
If the time you have set is not yet reached, a corresponding message will be displayed on the product
detail page to inform the customer when the product can be purchased.

This date only serves as an indication for the customer, from when the product will be available. However,
the product can still be purchased before that date.

EAN
Enter the EAN of the product.

Manufacturer number
A manufacturer-specific number can be entered here. The manufacturer number is not displayed to the



customer in the shop.

Specifications

Measures & Packaging

Product measurements

Width/height/length and weight
Here you can enter the measurements and weight of the product.
The information can be displayed on the product detail page, and can be used to calculate the shipping
costs.

Selling & Packaging Information

Selling unit
The selling unit is the quantity of the product, for example 700 ml or 500 gr.

Product unit
Select the unit of the product here. This can be piece or bottle. You can store the available units in the
administration under Settings > General > Product units.

Basic unit
With the basic unit you define the reference specification, e.g. price per 100 gr or per litre.



Packing unit
The packaging unit indicates how the product is delivered, e.g. in a carton or bottle. This information
appears in the quantity selection field of the product.

Packing unit plural
If the plural of the packaging unit differs from the singular, you can enter this additionally here. For the
packaging unit "bottle" e.g. bottles. This information will be displayed in the quantity selection field at
quantity >1.

To calculate the basic price of a product, the selling unit, product unit and basic unit are required. Please
note that the basic price is only displayed separately if the basic unit differs from the sales unit.

The basic price calculation in Shopware 6 is solved in a simple way:
The basic units are predefined under Settings > General > Product units with one litre and one
kilogram. If I sell a product with a quarter litre content, I enter the product unit "litre", the basic unit "1"
and the selling unit with 0.25 litre in the product. This provides all the information for calculating the
basic price. 

The same applies if you want to sell a product with a pack content of 100 g. The basic unit is 1 kilogram, so
you enter the product unit "kilogram" in the product. The basic price refers to one kilogram, so the basic
unit is "1" and the sales unit is "0.1".

Properties

You can use the properties to assign filterable information to the product, such as size or colour.
This information can then be used in the product listing to limit the selection and offer the customer a
better overview.
In the properties overview of the product you can select the desired entries from the property groups
created under Catalogues > Properties and assign them to the product. Several entries can be added to
the product from the individual groups.
More information about the properties can be found here.

To add properties to the product, first click on search values, this will open a menu with the available data
sets.

https://docs.shopware.com/en/shopware-6-en/products/properties


In this menu, all available properties are displayed on the left-hand side. By clicking on one of the
properties, the corresponding options are displayed on the right-hand side, which you can assign to the
product by clicking on the respective checkbox of the options.

Alternatively, you can search for the desired property or option in the search bar and then activate it by
using the checkbox.
 

The following feature is available to all customers with a commercial plan. Please note that the settings are
only visible after you have created the product.

To save time and get inspiration, you can use AI Copilot to configure properties based on a product
description. Here you can use your existing product description for or specify a completely new text.

The search function of the AI Copilot can be used to search for individual values, should a large text be
given and the AI generate many different properties.

With a double click on the property the name of this can be changed. Hovering over the property values
 allows you to remove individual suggestions and the three dots next to the properties can be used to
remove entire lines.

With a click on Save you can take over the selected suggestions for your product.

https://www.shopware.com/en/pricing/


Essential Characteristics

Under the item Essential characteristics you can select a template you have previously created, which
displays relevant characteristics of the product in the shopping basket and checkout.
Essential characteristics can be properties, additional fields, product information or the basic price.

Custom fields

https://docs.shopware.com/en/shopware-6-en/settings/essential-characteristics


In the custom fields area, the custom field sets assigned to products are displayed.

Please note that this area is only displayed if at least one custom field set is assigned for products.

The custom fields offer the possibility to create various additional data sets, e.g., a simple checkbox, as
well as the option to store an image or select a colour. This data can then be included in the template using
variables, for example.

Further information can be found in the article Custom fields.

Want to dive deeper?
You’ll find an interactive learning path on this topic in the Community Hub. Explore it step by step, try out
features directly, and grow your knowledge in a playful, hands-on way.

Advanced pricing

In the tab advanced pricing you can define different prices based on Rule Builder rules. You can
maintain the sales price, the list price and the cheapest price within the last 30 days in gross and net, as
well as define scaled prices.

Scaled prices can be represented here via an individual allocation of quantities and prices. 
 

http://docs.shopware.com/en/shopware-6-en/settings/custom-fields
https://hub.shopware.com/learn/unit/user-simple-mode-product-definition
https://docs.shopware.com/en/shopware-6-en/settings/rules


For the customer, the scaled price is then as follows:
 

Variants

The properties serve as the basis for creating the variants. Please note that these do not have to be the
same properties as those assigned to the product for the filters.
You can open the variant module by clicking on Variants in the upper navigation bar.

To create variants open the Variant Generator



In the first step choose under Select values (1) the property you want to use as a basis for the variants
with a click on (2) and now the available options appear on the right side. You can now activate the options
using the checkboxes for use in variant generation (3). On the left side, the number of active options
(4) is displayed in the properties after assigning the options.

Before you run the generation, you can define price surcharges (1) for individual options, which are
taken into account during the generation.

Value exclusion

You have the option of excluding certain combinations of options from the generation of variants.
This makes it possible, for example, not to offer a T-shirt in size L in the colour blue.

To do this, click on Value exclusion(1) and then on the Exclude values(2) button. This will take you to
the following screen.



Here you can define combinations of properties for which no variants are generated. Similar to the rules in
the Rule Builder, they are linked via “and”.

Example:
Color > is one of > Blue
and
Size > is one of > XS, XXXL

in order not to generate T-shirts in the color blue and the sizes XS and XXXL. Several groups of property
combinations can be created using the Exclude values(2) button.

After you have made the settings, you can generate the variants by using the button Generate variants.
After the variants have been created, the variant window closes automatically and the created variants are
displayed in a clear table.
If required, you can also display the variants sorted. For example, you can sort all variants in ascending or
descending order by price. Or you can have all the variants displayed in alphabetical order. To do this,
simply click in the respective column in the area where the heading appears. In this example, the sorting
options are: Variant (name), Euro (price), Stock, Product number and Active.

Now you can adjust the display of the variants in the storefront (1). You can define the order of the
individual properties and assign a separate image to each variant.



Here you can determine the order of the properties (1) as well as the order of the options (2) within
a property.

To assign images, you can either access the data already added in the Media section (1) or upload the
desired image directly from your local computer (2).

Under the item Product list you can select different display modes. If you click on Single main variant (1)
, you will be offered two setting options:
Via Main product (2) you can set that the product is displayed without preselected variants. In the listing,
the product is basically indistinguishable from a product without variants. When the product is called up,
the variant configurations are displayed as usual. Via Single Variant (3) you define that a variant
configuration is preselected in the listing. The variants are displayed by means of a drop-down list (4).
With this option, the preset variant can already be placed in the shopping cart from the listing.



In the storefront, the two options differ as follows. The left side shows the variant with the Main product
setting.
On the right side the variant with a preselected variant is shown using the Single variant setting.

With the option Fan out properties in product list (1) you have the option to extend the display to
several individual variants, depending on the associated property values (2). This means that the products
with the property values selected here can be seen individually in the storefront in the listing.

Storefront view.



If all property values are fanned out, this information is additionally displayed in the listing below the
product name.

Edit a single variant

information such as name, description, etc.
To change data for a single variant, you can remove the inheritance for individual areas and then define
the content on a variant level.

First open the variant from the variant list. You can do this by clicking on the variant name (1) or the "..."
(2) menu. In the "..." menu you can delete a variant.

Inheritance is represented by the chain symbol (1). To maintain your own content for a variant, remove
the inheritance by clicking on the symbol. You can now edit this section.



Quick changes

In the variant overview you have the option to quickly change some information of the variants without
calling up the respective variant detail page. To do this, double-click on the line you want to change. Now
you can change all the displayed information directly.

In some columns, a purple chain symbol is displayed. These columns inherit their information from the
main product. By clicking on the chain symbol, you can cancel this inheritance and then edit the respective
information. You can then change the prices, the stock or the product number for each variant. In the
Media column, a small preview is shown on the left, which product image is the preview image of this
variant. If you click on one of the images on the right, you can either remove the respective product image
or select it as the preview image. You can also upload a new image directly here or add an image from the
media management to the variant.

In the Active column, you can also activate or deactivate the variant completely.

Bulk edit

Bulk edit offers you a easy and quick way to change multiple variants at the same time.

You can select individual variants (2) or all variants that are displayed on this page (1). You also have
the option to select variants on multiple pages. The maximum of variants that can be selected at once are
1000. The number of currently selected products (3) is displayed above the variants. The option to
deselect all products (4) is only shown if you have selected variants from multiple pages. To edit the
selected variants click bulk edit (5), to delete all selected products click delete (6).

After clicking bulk edit, a pop-up window appears showing you the selected variants.



In this overview you have the option to remove variants from your current selection. Once you are satisfied
with your selection, click start bulk edit.

Mark the checkbox (1) of the informations you wish to change, update the values (3). Before this, the
inheritance to the main product must be removed via the chain (2), if it is still active. Click apply
changes to proceed.
Please note that only values for which the checkbox is ticked will be changed.

It is not possible to set the cover image by multiple change.
Updating the gross price does not change the net price.

The information to be edited is divided into blocks, such as properties or assignment, similar to the product
configuration of a single variant. In some blocks, where it is reasonable, you have an additional dropdown
with different options. This option decides how the changes within this block are to be handled.



Overwrite: If you select this option, the previous information will be overwritten by the now selected
information. 
Clear: This option removes all settings and information from this block. 
Add: With this option, only the selected settings are added to the variants. Existing settings will not be
removed. 
Remove: This option removes the selected settings from the variants, if they existed in the variants. 

A pop-up will show you the number of variants that will be changed. You must confirm this by clicking on
Apply changes.



Please wait until the system has updated the product information.

Shopware will notify you when this task has been completed. Now you can click Close to finish the process
and return to the overview.

Layout

In the Layout tab, you can assign a product page from the shopping Experience to the product. This gives
you the opportunity to design the structure of the product page yourself.



At this point you can either assign an already created layout (1) to the product or switch directly to the
shopping experience and create a new layout (2). You can find out exactly how to create the worlds of
experience here.

After selecting a layout, all segments of the selected shopping experience are displayed in the Layout area.
Initially, the content of the layout is presented grouped by blocks, so the type and number of blocks varies
depending on the layout. Here you have the option to change the shown content without having to switch
to the shopping experience and create a separate product page for each product.

SEO

SEO

Meta-Titles
The meta title should currently not exceed approx. 70 characters, otherwise it could be truncated in the
listing of search engines and similar.

Meta description
Currently, the length of the meta description should be about 130 to 160 characters. If the description is
longer than 160 characters, it may be truncated on the search results page, for example.

SEO Keywords
Additionally you can define keywords. These currently don't influence the ranking calculation.

https://docs.shopware.com/en/shopware-6-en/content/ShoppingExperiences


Use single canonical URL for all variantsThis option is only visible if the product has variants. If this is
the case, you can specify that all variants use the same Canonical URL. Once you enable this option, you
can select which variant should be used for the URL under Variant for Canonical URL. 

SEO Urls

In the SEO Urls section, you can define a separate Canonical Url for each sales channel. To do this, you first
select a sales channel. Afterwards the SEO Path field will show the SEO path valid for the product, which is
generated according to the SEO settings. If the product is assigned to several categories, you can also
define the main category.

Cross-Selling

You can configure an article recommendation for your article using Cross-Selling, e.g. to display the
matching accessories directly on the article detail page.

To enable cross-selling of an item, you must add a new cross-selling product.



In the overview you can first enter the Title (1) of your cross-selling, which will be displayed in the
storefront.
Use the Active (2) button to determine whether the cross-selling should be displayed for the product or
not.
In the drop-down list Type (3) you can choose between Dynamic product group and Manual
assignment. With manual assignment it is possible to select a single product for cross-selling.

Since there are differences in the configuration between the two options, we will show you both ways
below.

Dynamic product group (3):
By flipping the switch at Active (2) you can either enable or disable cross-selling.
Under Position (4) you can determine the order of the tabs of your cross-selling actions in the storefront
by entering numerical values like 1,2,3, etc.
The positioning of the tabs is only visible if you have activated more than one cross-selling action for a
product.
In the next step you have to enter the desired product group (5) so that you can determine an article for
cross-selling.
Here you can find all your product groups, which you have already stored in the admin.
Click on Sorting (6) and you will have the possibility to sort the display of products by name, price or
publication (descending, ascending) date.
The maximum number of products (7) defines the maximum number of products to be displayed in
cross-selling on the item detail page of your item. You can freely determine and enter this value.
Afterwards you have the possibility to see a preview of all applicable articles by clicking on
Open preview (8).

Manual selection (3):

http://wiki.shopware.in/en/shopware-6-de/Catalogues/Dynamicproductgroups


After selecting manual assignment, the view of the window changes. The options Title (1), Active (2) and
Position (4) remain the same, but other options, such as Sort, Maximum number of products and
Open preview, are completely omitted for manual selection.
In the new drop-down list Product assignment (9) you have the possibility to select one or more
products of your shop to be added to the cross-selling. As soon as you have selected at least one product,
it will appear further down in the view (10).

Appearance in the storefront

As soon as the cross-selling of an item is activated, the products from your selected product group will be
displayed.

Reviews



In the Reviews section you will get an overview of the reviews given for this product. Reviews are only
displayed in the storefront if you have marked them as visible. You can edit them via the context menu,
which you can call up by clicking the "..." button.

If your product has no reviews yet you can also open other reviews from other products.
You can find further information on the detailed editing of reviews here.

Advanced/simple editing mode

If you only want to edit the basic data of the product, you can adjust the displayed data in the general and
specifications sections using the icon in the upper right corner.

Deactivating the advanced mode (1) hides all areas and fields within a section that are not absolutely
necessary. You can completely hide individual sections in the area using the check boxes (2).

http://wiki.shopware.in/en/shopware-6-en/catalogues/reviews


If you deactivate the advanced mode, this looks like this

Section navigation

Section

Bulk edit

The bulk edit of products is explained in the article on the product overview. Here we also show you how to
change prices and extended prices using the bulk edit function.
 

Digital Products

Many retailers sell not only physical products but also or even only digital products. Examples of such
digital products are many: eBooks, music downloads, movies and series, games, software and software
extensions, online courses, fonts, graphics, and more.

Do you also want to offer digital products? With Shopware this is now possible without any hassle. Under
products, you can create a digital product in the administration and upload the product as a file.

It is also possible to offer different variants for one product, for example, a book in physical and digital
form.

https://docs.shopware.com/en/shopware-6-en/catalogues/product-overview


All digital products are batched in the backend so that they are immediately recognizable. In order for your
digital product to be saved, the file must be bound to the product so that it can later be sent to your
customer.
Digital products behave almost exactly like physical products in the storefront. When the product is
ordered, an additional checkbox is automatically displayed that indicates the legal basis of digital products.

After the purchase, customers will be notified by email as usual. And will receive another email with the file
attached upon successful receipt of payment. In addition, the customer can now download the file again in
his account under "Orders".



Properties

 

The properties offer you the possibility to provide your products with filterable information. Furthermore,
the properties are used as a basis for the generation of variants.
For this purpose, you can create various properties and assign corresponding options to them, e.g. the
property size with the options XS, S, M, L, XL and XXL.

Overview

Under Catalogues > Properties, you will first find an overview of the already available properties (1)
with the corresponding property values (2) and an (optional) description (3). It is also shown here
whether the properties are displayed in the product filter (4) or not.

On the right side of each line you can use the "..." button (5) to open the context menu for the
corresponding property. Here you can open, edit or delete this property.
By clicking the button Add, you can open the mask for creating a new property.

https://docs.shopware.com/en/shopware-6-en/catalogues/products#variants


When deleting a property, please note that the property with all options will be removed from all products
to which it is assigned.

Since the editing mask is identical to the mask for the new creation of a property and the characteristics,
we show the individual points using the example of a new property.

Creating a new property

Property

In the basic information you first enter the name (1) of the property.
The name will then be displayed later, e.g. for the products on the detail page in the product description or
in the filters in the product listing.
Optionally, you can enter a description (2) and specify whether the property should be displayed in the
product filter of product lists (3).
Four different views (4) are available for the display in the front end:

Image: An image can be stored for the individual options, which is then displayed in the filters

Text: The options are displayed as text in the filters

Dropdown: Selected property values of a variant product are displayed in a dropdown menu on the
product detail page. The options are displayed as text in the filters

Colour: If a colour is highlighted in the options, it will be displayed in the filters

You can also choose from two sorting options (5):



Alphanumeric: letters are sorted in the order a, b, c, etc., numbers 1, 10, 11, ... 2, 20, 21, ... 3, etc.

Individual: With the individual sorting, you can determine the order by using the position field in the
individual options. The option with the position 1 is at the top of the list.

In the field Position (6), you can specify the position of the property. This position determines the order in
which the properties are listed on product detail pages.

Now, after you have entered and saved the basic information, you can add an option using the button Add
value (7).

After clicking on the button a new input mask opens.
 

Values

First you assign a name (1) to the option, which will be displayed when using the text view.
The position (2) is used for the individual sorting to determine the order. The lower the value, the higher
up the entry is in the list.
If colour was chosen as representation, the HEX colour value stored in the field colour (3) is used,
alternatively you can choose a colour from the colour palette. The colour will then be displayed e.g. in the
filters in the product listing.
If you want to use a picture as display, you can select a picture in the field Default image (4), which will
then be displayed in the storefront.



 

Here you have the direct possibility to upload already existing pictures (1). If the desired picture is not
yet available, you can directly upload it as a file (2). For adding media the following view will then open.

 

The button Upload files (1) opens a window where you can select and upload local files.
With the "..." button you can upload a file via URL (2) and after clicking on it you will switch to the view
to add a file directly via URL.

In the field URL (1) you enter the URL to the desired image, then use the button Upload (2) to add the
image.

After you have entered all the desired data for the option, you can add it by clicking the Apply button.
Now this option is available for selection in the products.

Want to dive deeper?
You’ll find an interactive learning path on this topic in the Community Hub. Explore it step by step, try out

https://hub.shopware.com/learn/unit/user-properties


features directly, and grow your knowledge in a playful, hands-on way. 

Categories

In the category management you administrate the category structure of your shop, and in Shopware 6 the
categories are also used to organize the shop pages and the service menu.
You can find the module under Catalogues > Categories.

Category overview

Categories are the menu items in the main navigation but also in the service navigation or the footer
navigation.

On the left side you will find the category structure displayed as a fold-out menu. There you have the
possibility to change the sorting by drag & drop - this is possible on every category level and you can also
move a category into another category as a subcategory.
As mentioned at the beginning, the categories are also used for footer navigation and the service menu.
For a clear administration it can be useful to work with two or three category trees, as you can see on the
screenshot above.

Context menu

https://docs.shopware.com/en/shopware-6-en/tutorials-and-faq/basic-setup


For each category, the context menu can be opened with the "..." button, which can be used to execute
further functions.

New category before: Creates a new category on the same level before the selected category

New category after: Creates a new category on the same level after the selected category

New subcategory: Creates a new category a level below the selected category

Edit: Opens the display on the right side for editing the selected category

Delete: Deletes the selected category including all subordinate categories

In the examples section for creating new categories, we explain the differences between the category
options from the context menu.

Create category

To create a new category, open the context menu of an existing category and select one of the menu items
New category before, New category after or New subcategory.
Afterwards a mask will be displayed in the menu at the appropriate place, in which you enter the name of
the new category and confirm with the check mark.

https://docs.shopware.com/en/shopware-6-en/catalogues/categories#examples-of-how-to-create-new-categories
https://docs.shopware.com/en/shopware-6-en/catalogues/categories#context-menu


Please note that a newly created category is inactive and is not displayed in the frontend.

You define the content of the category in the editing menu, here you can also activate the category.
You will find more information in the next section Edit category.

Edit Category

To open the editing view of a category, you can either click directly on the name of the category in the list
on the left or open the context menu of the category and select Edit.

The editing area is split into four tabs. General, Products, Layout and SEO. However, these are only
required in the default category type Page/List. For the other category types, only the General tab is
needed.

Want to dive deeper?
You’ll find an interactive learning path on this topic in the Community Hub. Explore it step by step, try out
features directly, and grow your knowledge in a playful, hands-on way. 

General

The General tab is divided into several items for better clarity.
Please note that the available configuration options depend on the selected category type

General
In the General section, you define the type of category you want to use.

Name (1): The name of the category that's given when creating the category, although it can still be
changed here later.
Category is active (2): This switch toggles the category active and inactive. The active category is shown
in the frontend and is used, if switched to inactive it's not in use and won't be shown in the frontend.
Tags (3): Here you can store keywords these can be used in other programs areas (e.g. products,
customers).
Category type (4): Select the category type here, this has an effect on the behavior of the category.
Page / List: A standard page that is used, for example, for a product listing or a shop page.

http://wiki.shopware.in/en/shopware-6-en/catalogues/categories#context-menu
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Structuring element/entry point: A sorting element is used to structure the category tree, such a category
cannot be called up, but only provides a menu entry with further sub-items.
Link: Enables direct linking to an entity of the shop or a freely definable page. You can find more
information below in the Link section.

Customisable link
If you have selected Link as the category type, these options available to specify where link should go.

Link type (1): Select you if you want the link to link to an external page or to an entity within your shop.
Entity/link target (2): If you select External as the link type, you can enter the URL to the target. If you
select Internal as the link type, you can select the entity to be linked to here. This can be a category, a
product or a landing page, for example.
Open in new tab (3): Activate this checkbox if the link should open in a new tab instead of in the same
window.

Entry point
If you have selected Page/List or Structure Element/Entry Point as the category type, these options are
available to you.

Entry point (1): Here you define the point in the navigation where this category is to be reached. The
category with its subcategories can be displayed in three different forms on the storefront: Main
Navigation, Footer Navigation and Service Navigation. The entry point is therefore important because your
category as well as the subcategories determine how the respective navigation is structured.

Main navigation: This is always the best choice if you want to display a classic category structure with
products or shopping experiences. By default, the navigation is located in the upper area of the storefront,
below the shop logo. So if you have your category with the respective subcategories with products and
content, choose this navigation.



Footer navigation: With this navigation you can determine the structure in the lower area of the
storefront (footer). This navigation is useful if you want to include pages such as your imprint or privacy
policy. The  footer navigation is structured and ordered according to your category and subcategories.

Service navigation: This is located at the top right of the storefront and, like the footer navigation, are
again displayed on the basis of a category with the respective subcategories.

Sales channels (2): Select the sales channels for which the category should be available. You may select
multiple sales channels.
Configure home (3): If additional the category functions as the home page for another sales channel, you
can configure this here. These configurations only take effect if the category is opened as the start page in
the selected sales channel.
As a sub-category, the settings made here continue to apply.

Menu settings
In the menu settings, you can enter further information on the category. For example, this information can
used in an Shopping experience page using the data assignment function.

Hide in navigation (1): If you activate this switch, the category is hidden from the navigation bar.
Display image (2): The display image is shown in the drop-down menu, for example, but can also be
automatically integrated into an shopping experience page using the data assignment function. 
Description (3): Enter a useful category description to provide your customers with information about the
category. The description can also be integrated into the into an Shopping experience page using the data
assignment function without having to manually maintain the text there again.

Products



You can assign products to the category by using the product assignment.

Type (1): You can either fill the category manually or have it filled by a dynamic product Group. You can
find out how to create a dynamic product group here.

If you have already assigned articles manually, but then subsequently set the type to Dynamic product
group, the articles are no longer displayed in this category. However, they will still be displayed in the
categories above. 

Products / Dynamic product group (2): If you have selected manual selection as the type, you can
assign the products manually here. If you have selected Dynamic product group as the type, select the
dynamic product group you want to assign here. 
Product list (3): Here you see a list of the currently assigned products.

Layout

Here you define the appearance of the category. To do this, you assign a layout created in the shopping
experiences under assign layout. You can also use the create new layout button to switch directly
shopping experiences editor and create a completely new layout there. (information on how to use the
editor in the shopping experiences can be found in this article).

After selecting a layout, all segments of the selected shopping experience are displayed in the Layout area.
Initially, the content of the layout is presented grouped by blocks, so the type and number of blocks varies
depending on the layout. Here you have the option to change the shown content without having to switch

https://docs.shopware.com/en/shopware-6-de/Catalogues/Dynamicproductgroups
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to the shopping experience and create a separate category page for each category.
 

Please note that the settings in the layout selection can overwrite your shoppping experience
configuration.

Customisation hierarchies

Even when making individual layout adjustments in the categories of Shopware, there is the option to
customise them in different languages. This means you can design the apperance of your shop separately
for each language. There is a specific order in which Shopware looks for adjustments when a page is
accessed.

This order is as follows:



Here is a simple explanation of how it works:

1. Your customisations take priority: If a language does not have its own customisation, Shopware
first checks if there were any adjustments in the parent language or the system default language for
that category.

2. No customisations are available: If you have not made any customisations for a specific
language, Shopware falls back to the layout level, starting with the selected language. You can find
out how to configure parent child languages here. If no customisations exist there either, the system
default language is used.

3. Finally, the selected layout is used: If no customisations exist for the current language, the
parent language or the system default language, Shopware falls back on the layout. It first checks
whether a layout exists for the selected language.

Examples of customisation hierarchies

In all examples, we assume that we have the language "German" and "Austrian", which inherits from
German.

Example 1

I have only maintained customisations in English. As a result, the English customisation of the layout will be
displayed in all storefront languages.

Example 2

I have maintained customisations only in Austrian, while the layout itself is available in English and
German. This results in the following:

English storefront: The layout in English is displayed

German storefront: The layout in German is displayed

Austrian storefront: The customisations in Austrian are displayed

Example 3

I have maintained customisations in both German and English. This results in the following:

English storefront: The customisations in English are displayed

German & Austrian storefronts: The customisations in German are displayed

Visibility

https://docs.shopware.com/en/shopware-6-en/settings/languages#edit-an-existing-language


If you have added a layout, you can see in which viewport the layout is visible (1).
Below that you can see if the respective block element is visible (2). In this case the block will be hidden in
the mobile viewport. You define whether a layout or a block should be shown or hidden in a specific
viewport directly in the configuration of the Shopping Experiences.

Sorting 

Here you have the option to assign a sorting order to the products in the listing under Category listing. If
you enable the "Show Product Sorting" option, a drop-down menu will be created in the frontend, providing
customers with sorting options.

If you enable the "Use Custom Sorting" option, two new options will be unlocked. In the Default Sorting, you
can specify which sorting should always be used as a fallback and be pre-selected for the user. Through the
Product Sorting option, you can add custom sorting orders that will also be available in the frontend. You
can set the order of priority to determine the sequence.

SEO

In the SEO section, here you enter search engine relevant meta data for this category. In addition to an
SEO title and an SEO description, you can enter additional keywords that are taken into account in search
engine searches. 
Under the heading SEO URLs you can define an SEO URL category for every sales channel. These are based
on the SEO settings you have made. 

https://docs.shopware.com/en/shopware-6-en/content/ShoppingExperiences?preview=74f1afef772dc9ff009e19a37f5ea383c0a83b58ec0d4fa21d5513997bb08287#visibility-by-viewport


Examples of how to create new categories

We are going to show you some examples on how to correctly create new categories for your shop.
 

Example 1:
You want to add more categories (Food, Clothing, Leisure & Electrical) for your products to your top
category "Home", which is already assigned to your sales channel.

In this case, you must add new subcategories to the top category "Home" using the context menu so that
the categories are created at the lower level of your previous category. The subcategories will then be
displayed in your shop as categories for your products.

Example 1:
You want to create your own categories for your subshop.



The best way to create a new category is to open the context menu of your previous category "Catalogue
#1" and then click on New category after. This will create a new category at the same level, which you can
call "Catalogue #2", for example. Next you need to create new subcategories - as explained in example 1.

Landingpages

Landing pages are pages that do not appear in the shop's navigation. They can be reached externally
under the URL of the sales channel + the individual URL of the landing page.

Below the category overview you will find the overview of the landing pages that have been created. Unlike
the categories, the order is not important here. You can remove, duplicate or edit the corresponding
landing page via the context menu (1) on the right-hand side. 
You can create a completely new landing page using the add landing page (2) button.

General

In the general area, you must first configure the basic settings.



Name (1): The name of the landing page is used in the overview and is used as the title of the landing
page.
Landing page is active (2): Only if this tick is active, the landing page can be reached under its URL.
Sales channels (3): Select the sales channels here in which the landing page is to be embedded. The
landing page is only accessible in combination with the URL of the selected sales channels.
Tags (4): Here you can assign tags to the sales channel to make it easier to find in the admin.

SEO

In the SEO section, here you enter search engine relevant meta data for this landing page. In addition to an
SEO title and an SEO description, you can enter additional keywords that are taken into account in search
engine searches.

The SEO URL is a mandatory field. This is the URL under which the landing page can be called up directly.
If you enter the value start here, for example, as in the screenshot, the URL of the landing page is
www.mysaleschannel.co.uk/start, depending on the sales channel.

Please enter only the name of the landing page, like on the image start. The URL will be generated
automatically.

Layout



Here you define the appearance of the ladningpage To do this, you assign a layout created in the shopping
experiences under assign layout. You can also use the create new layout button to switch directly
shopping experiences editor and create a completely new layout there. (information on how to use the
editor in the shopping experiences can be found in this article).

After selecting a layout, all segments of the selected shopping experience are displayed in the Layout area.
Initially, the content of the layout is presented grouped by blocks, so the type and number of blocks varies
depending on the layout. Here you have the option to change the shown content without having to switch
to the shopping experience and create a separate category page for each category.

Dynamic product groups

The dynamic product groups can be found in the admin under Catalogues > Dynamic product groups.
Dynamic product groups are groups of products that are formed by dynamic rules and can be played at
different locations in your shop.

Learning path available
You’ll find an interactive learning path on this topic in the Community Hub. Explore it step by step, try out
features directly, and grow your knowledge in a playful, hands-on way. 

Overview

In the overview, all already created product groups are listed with their name and description. The date
of the last change and the status of the product group are also shown. The status indicates whether a
product group uses valid rules and can therefore be used. A product group can be invalid, for example, if it
uses rules of a plugin that is deactivated.

Using the context menu in the last column of each product group, it can be edited, duplicated or
completely deleted. With the button create product group you add a new product group to the
overview.
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Creating product groups

General information

To create a new dynamic product group, first enter a meaningful name and description in the general
information section. Both are displayed in the overview for better orientation. You can then save your
settings via the Save button and, if necessary, create a duplicate of the dynamic product group directly via
Save and duplicate.
 

Filter

In the Filter area, you define rules through the corresponding module in order to determine which itmes 
belong to this product group.
In this module, you first select a property (1) and a corresponding condition (2) that must be met.
Use the AND (3) button to create a further condition that an item must meet in order to belong to this
group. In addition to an AND link, you can also create a further condition as an OR (4) link. In this case,
one or the other condition must be met for the item to belong to the group.
You can also nest the conditions by using the SUB-CONDITION (5) button. In this case, an item is part of
the product group if it meets the main condition and the sub-condition. The sub-condition can consist of
one or more conditions. In the sub condition, you have the option of creating another sub condition. This
can be continued indefinitely.
Using the context menu (6) behind the condition, you can create a new condition directly before or
after the respective condition.
The Preview (7) button shows you all products that would belong to the dynamic product group with the
currently selected conditions.

Operator



You can choose one of the these operators:
Is equal to, Is not equal to, Is equal to any of, Is not equal to any of, Is equal to all of, Is not
equal to all of.
 

Examples

Below we list some examples of how a product group can look like. In general, the conditions of a dynamic
product group are based on rules of the Rule Builder. You can learn how to use the rule builder here.

Product condition

In this case, the dynamic product group consists of the selected products.

Category condition

In this case, the product group contains all products that are assigned to the selected categories. Individual
categories can be identified by the displayed category path.

Property condition
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In this example, all products that have a certain property are included.

Property value

This condition contains the property expression of a property.

Tag and sale condition

In this example, all products are part of the product group if you have set promotional items as the tag
AND if they are sales items.

Price condition

In this example, all products that cost more than 100 euros are part of the product group. The value 100
refers to the currency, which has a factor of 1.

Stock condition

In this example, all products with a stock larger than 20 are part of the product group. 



Multiple conditions

In this example, two conditions must be met for an item to belong to this product group. Firstly, the article
must be tagged as a promotional article.
The second condition is considered to be fulfilled if the article is either a sale article or an article from a
specific manufacturer.

If you want to use several conditions and include just the operator AND, you should work with the
operators Is equal to all of/ Is not equal to all of.

Custom field

In addition to the standard properties that are available in the drop-down menu, you can also use custom
fields that you have configured yourself. In this example, an individual custom field of the type "Checkbox"
is used, which was created beforehand. You can find more information about the additional fields here.

Delivery time
 

https://docs.shopware.com/en/shopware-6-en/settings/custom-fields


The 'delivery time' defined in a product can be used as a criterion for dynamic product groups.

When selecting the available delivery times, the display and sorting of the available options is based on the
delivery times freely defined by the merchant in the settings of the admin and already selectable in each
product.

If an existing delivery time is removed, the delivery time within the dynamic product group condition will
also be removed, and it will no longer function correctly.

Assign dynamic product groups

Categories

You have the option to fill the content of a category dynamically. This is useful, for example, for sales or
manufacturer-specific categories. You can find information on the administration of categories here.

Product comparison

In the product comparison, the dynamic product groups are needed to fill the feed with content. Here you
can find more details about the product comparisons.

Shopping Experiences

In the shopping experiences, you can use dynamic product groups to fill product sliders. You will find the
product slider element in the Commerce block category. You can find more information about the
shopping experiences here.

Reviews

In Shopware 6 your customers have the possibility to rate your products. The reviews then end up in the
administration, where you can check, approve and comment on them.
 

Administration
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You can find the reviews in the administration under Catalogues > Reviews.

Overview

In the overview, you can see all relevant information about a review at a glance. This includes the title, the
rating stars, the reviewed product, the customer who submitted the review, and the date and time of the
review. You can also see whether the review is currently approved and therefore visible and whether the
store owner has commented on it.
You can use the context menu on the right side to get the details of the rating or delete the corresponding
rating. 
 

Details

The rating details will show you a summary with all important information of the rating. In addition to the
information that has already been displayed in the overview, the complete evaluation text is now also
displayed here.
 



Under Properties (1), you can approve the review so that it is displayed in the storefront when the option
is enabled, and not displayed when the option is disabled. You can also specify here which language the
review should be shown in on the frontend. In all other languages, the review will only appear if the
customer explicitly chooses to view reviews in all languages.

Finally, you can add a comment (2). If you wrote a comment for a rating, it will be displayed in the
frontend below the rating.
 

Disable reviews

If you do not want your customers to be able to rate your products, you can deactivate the rating function
for each sales channel. In this case, the rating tab on the product detail page will be completely hidden, so
that no previous ratings will be displayed.
This is possible in the settings under Shop > Products > Show reviews.
You can find more information about the product settings in this documentation.

In the frontend

In the frontend with our Responsive Theme, the customer will find the ratings on the product detail page
next to the product description. Here all current reviews that are active and set for the language are
displayed. 

Note that the ratings may show up on a different location depending on the theme that you use. The theme
creator should be able to tell you where they are displayed. 
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In the ratings, the customer first sees an overall rating (1) in the form of 1 to 5 stars. Below this, the
customer can see how other customers have rated this item in percentage and absolute terms (2).  Using
the checkbox on the left he can limit the listing to ratings of a certain number of stars. 
On the right side you see the listing of the ratings (3). Here you can either see all ratings or only those
the customer has selected under (2). 
With the button Show ratings in other languages (4) you can display ratings from other languages in
addition to the ratings for the current language and under Sort by (5) you can change the sorting of the
listed ratings. 
By clicking the button Write a rating (6) the customer can write his own rating. A rating must contain at
least 40 characters.
 

AI-generated review translation

With Shopware AI, your customers have the option to see reviews translated into their language.

You can activate the function in the settings under reviews. There you can also define for which sales
channel the translation function should be available.



The function is now available in the storefront in the reviews of the product detail page. By clicking
Translate review to English (1), the review is translated into English with the help of the AI.

The translated review can also be displayed again in the original language in which the review was written.
To do this, simply click on See original (1).
 

AI-generated summary of ratings

The AI-generated summary of ratings is available to you from the Shopware Rise plan.

For each product that has already received reviews, you have the option to display a summary of all
reviews in the storefront. To do so, open the corresponding product (Catalogues > Products) and switch
to the Ratings tab. Under the ratings you will find the AI Copilot, which you can use to summarize the
ratings.

Based on all available product reviews, AI Copilot can create a summary of the reviews.



After you have opened the AI Copilot, you can first choose a phrasing and select whether the summary
should be neutral or positive.
If you then click on Renew text, the summary of the ratings will be generated. Note that this was generated
by an AI. The summary can therefore be inaccurate or misleading. In this case, you have the option to
customize the AI-generated summary yourself. Once you are satisfied with the generated and customized
text, you can apply it by clicking the Apply button.

In the overview, you can now finally decide whether this summary should also be displayed in the
storefront. The summary can be regenerated or edited at any time via the context menu.

The summary is displayed in the storefront above the reviews so that the user can identify the most
important reviews without having to read through all the reviews.
 



Orders

In this area you can find out everything about orders within the administration.

We go here into the overview, as well as the configuration to the orders of your customers and explain to
you in detail what there is to be considered here.

Create an order in admin

There may be situations where you may want to enter an order manually for the customer. For this there is
a module in the administration where you can create orders.

General

In the order overview you can use the button Add order (1) to open the mask for creating a new order.

Create order

Select customer



When you create a new order, you must first select an entry from the customer list (3) in the Customers
area (1). In addition to the name, the customer number, the sales channel and the e-mail address are
displayed in the customer list.
Alternatively, you can create a new customer directly from the menu (2). You can also call up the customer
directly via the edit icon (4).

Products

In the section Products (1) you can add items or products for the order. Please note that the search field
only searches the items of this order. You will learn how to add items in the next sections.



Add product

To add a product to the order, it is first necessary to add a new order item. This is possible via the Add
product button.
After the line has been added, you can select the desired product (2). To do this, double-click on the line
and editing is now possible. The price of the product will be determined automatically at first, but can be
changed later. Whether the price column is displayed in gross or net depends on the customer group to
which the customer is assigned. Based on the price and the quantity (1), the total price is calculated.



The default tax rate of the product is entered as the tax rate (4) after the line item is created. After
creating the item it is possible to change the tax rate.
By clicking the button with the checkmark (4) you can confirm your entries and the record will be saved.

Add custom line

An empty position is used to add a product that does not exist in the shop. This allows you to quickly add
an item without having to create a product in the shop first.

You can add an empty position in the drop-down menu next to the "Add Product" button (1) by
clicking on the item Add empty position (2). You can then edit the added row by double-clicking on it.
As name (4) enter a name for the item, this name will later be displayed in the order confirmation and on
the order documents.
To ensure that the gross price (5) is displayed correctly, you must first define the tax rate (6) for the
item.
After you have added the quantity (3), you can save your entries by clicking the button with the check
mark (7).
The total price will then be calculated automatically.

Add credit note

You can create an item with this function, which you can use to store a manual credit note (independent of
a possible existing discount campaign) for the order.



You can add a credit note in the drop-down menu next to the "Add Product" button (1) by clicking on
the item Add credit (2). You can then edit the added row by double-clicking on it.
In the column Name (3) you enter a name for the credit note. If possible, this should be meaningful, as it
will be printed on the documents for the order later. The last information required is the value that the
credit memo should have. This is stored in the column gross price (4).
The tax rate is determined automatically on the basis of the product items stored in the purchase order. It
is therefore not possible to adjust the tax rate manually.
Finally, you save your entry by clicking on the tick button (5).

Options

Options (1): There you can configure the order, payment and shipping.
Automatic discounts (2): Specify whether discounts should be applied automatically.
Order language (3): Here you can define in which language the emails and documents should be
created.
Discount (4): If you want to grant a discount to the order, you can store the discount code here.



Payment method (5): Define the payment method to be used. You can choose from the payment types
available for the sales channel
If a payment method is not listed, please check that the payment method "Allow as subsequent payment
method" is marked and assigned to the sales channel.
A PayPal payment can be called up in the customer account after the customer has created the order. You
can find further details in the section Paying for orders with PayPal
Billig address (6): Type in the billing address.
Currency (7): Select from the currencies released for the sales channel.
Shipping method (8): Select a shipping method from the settings available for the sales channel.

Shipping costs (9): Here you can enter an individual shipping cost amount. The currency will be adjusted
automatically once you have selected a currency.
Shipping address is the same as billing address (10): Activate this option if you want to use the
billing address.
Shipping address (11): If you check the previous option, the billing address will be used automatically. If
you have not activated the previous option, you can select a different delivery address here.

When you have entered all the information, click on Preview (12).
Note: The order is not yet saved!

Save order
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To finally create the order, click on the button Save order (1). After the order has been saved, the order
confirmation e-mail will be sent to the e-mail address stored in the customer account.

Manually change shipping costs 

In the upper section Details you can choose which shipping method should be used for the order. The
corresponding shipping costs are automatically stored. However, in some cases it may be necessary to
calculate shipping costs that differ from the standard. For this purpose you have the ability to change the
shipping costs for this order.

To adjust the shipping costs, double click on the entry with the shipping costs (1) below the order items.
This will open the edit mode where you can enter the desired shipping costs.

Details



In the upper area Details you first enter the general information about the customer and the order.

Once you have saved the order, in the details section (1) you will find all the important information about
payment (2), shipping (3) and general information about the order (4).

Further functions

Create customers

If you want to create an order for a person who is not yet a customer, you do not have to switch to the
customer overview first. You can directly call up a modal with all necessary functions by clicking on the
button Create customer.



In the tab Details (1) you enter the general information about the customer.
Here you can determine whether the customer should only be stored as a guest. In this case it is not
necessary to assign a password. However, the customer will not be able to log in to the account on the web
store.

Under billing address (2) you can enter all necessary details about the billing address.
The same applies to the delivery address (3). If this is the same as the billing address, you can confirm
this by clicking the button corresponds to billing address. In this case you do not need to enter the details a
second time.

Delete position

The option to delete an item from the order is displayed as soon as you click the checkbox at the beginning
of the desired item.
The checkbox in the header line allows you to select all items.

Paying for orders with PayPal

If you create an order for a customer in the admin and the customer wants to pay with PayPal, the payment
process has to be done after the customer has created the order.
For this purpose the customer has the possibility to access the PayPal payment process through his shop
account.
How this is possible is described below.



The first step is for the customer to call up the order in his customer account through the menu Orders (1)
. In the order, he then clicks on the "..." menu (2) in the top right-hand corner and selects Change
payment method (3). This opens the view for editing the order.

The name for the menu item "Change payment method" can be adapted using the text module
"account.orderContextMenuChangePayment"

Alternatively, the order can be opened for processing through the link in the order confirmation e-mail.

Should PayPal already be selected as payment method, it is sufficient to accept the terms and
conditions (1) and then click on the button Confirm change (2) to call up the PayPal payment window.

If PayPal is not yet selected as payment method, this can be changed by clicking on the button Change
payment method (3).

Orders



Overview

The order overview (1) provides you with a list of all orders placed by your customers.
With the button Add order (6) you can call up the module for creating an order. More information about
creating an order can be found here.
In the overview, you have the option to hide/show individual columns (4) using the drop-down menu
(2) or to use a compact mode (3), which summarises the displayed table a bit more.
You can also manually define the sorting of the individual columns (5) to adjust them according to
your wishes.
To the right of the overview, you will find tools (7) to update the displayed orders or to filter them further
and thus narrow them down more precisely. 

Learning path available!
You’ll find an interactive learning path on this topic in the Community Hub. Explore it step by step, try out
features directly, and grow your knowledge in a playful, hands-on way. 

Filters

If you click on the Filter Button, the following list of options appears.
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You can combine options within the filter to reduce the list of results. The filter-options add up, so every
additional entry reduces the list.

Filter options

Option  Description

Affiliate code (1)
The Option Affiliate Code filters the List of Orders to those in which the code
was used.
The List of Options only appears if there are Affiliate Codes defined.

Campaign code (2) Here, you can choose a Code to filter the Orders upon a Campaign. 
The List of Options only appears if there are Campaign Codes defined..

Documents (3) Choose, if you want to see Orders with or without Documents attached.

Order date From
and To (4)

Choose a timeframe in which an order was placed. If you click on the
calendar symbol on the right a date picker appears.

Order status (5)
Filters the status of an order.
(Open / In progress / Cancelled / Done)
A multiple selection is possible.



Option  Description

Payment status (6)

Searches orders upon payment status.
(Cancelled / Chargeback / In progress / Unconfirmed / Refunded /
Reminded / Authorised / Open / Paid (partially) / Failed / Paid
/Refunded (partially) )
A multiple selection is possible.

Deliverystatus (7)

Searches orders on the state of delivery.
(Returned / Returned (partially) / Shipped / Canceled / Open /
Shipped (partially) )
A multiple selection is possible.

Payment method
(8)

Set a filter on the payment method.
You can choose between payment methodes. What is selectable depends
on installed payment plugins such as PayPal, Amazon-Pay.
A multiple selection is possible.

Shipping method
(9)

Searches orders on the selected shipping methodes.
You can select between shipping methodes that are defined in the settings
of your shop.
A multiple selection is possible.

Sales Channels
(10)

Sets a filter on the sales channel(s) that are available in your shop.
A multiple selection is possible.

Billing Country (11) Searches orders on the billing country(s).
A multiple selection is possible.

Shipping country
(12)

Select orders on countries the deliveries are shipped. 
A multiple selection is possible.

Customer group
(13)

Filters orders on customer groups.
A multiple selection is possible.

Tags (14) Filters order on given Tags. 
A multiple selection is possible.

Products (15) Select orders on products.
A multiple selection is possible.

Order details



The order details can be opened by clicking on the order number (1) or the item View and deleted (3)
within the context menu (2) of the order.
Here, you can view the selected order in detail and manage the items and the accounting or delete the
order. 
However, once an invoice has been created, the option Delete can no longer be selected.

General

In the General tab, you will find the most important information and the order items.

Info

In the info area, you will find the most important information about the order as well as the current
payment, delivery and order status. 
You can cancel the respective order there if necessary.

Summary (1): Here, you can see a summary of the order number, the customer, the exact order time and
the selected payment and delivery method. 
Order total (2): Here you can see the current order total and when it was last changed.  
Status (3): Here, you can view and change the status of the payment, delivery and order.
Tags (4): The tags allow you to store keywords for your product. These keywords can then be used within
the rules, for example. If you click in the field, the keywords already stored for other products, media or
customers will be displayed. To add a new word, you can simply write it in the field and confirm with Enter.

Status

If you change a status via the respective drop-down menu, a modal opens which you can use to send an
email to the customer about the new status.
You can also attach documents already generated for the order (e.g. delivery bill or invoice) to the email.



You can select the documents to be sent from the list (1). If you do not want to send an email, set the
Send email to customer (2) switch to inactive before updating the status (3).
 

The email is filled with a template of the corresponding type.
If no corresponding template has yet been assigned to the sales channel in which the order was placed,
you will first receive a selection window in which you can then assign the template.

An X means that the receipt has not yet been sent. With a √, the receipt has already been sent.

In the overview, you can select from existing templates (1). If no or no suitable template is available,
you can directly open the editor to create a template (2). You can confirm your selection by clicking the
Assign email template button (3), after which the new status is set.
If you want to change the status without assigning an email template, you can do this by clicking the
Don´t assign an email template button (4).

In Flowbuilder, you can specify which email template is to be used for which status. You can find out how to
use the Flowbuilder here.

 

Cancelation
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As mentioned above, you can cancel an order via the order status.  

This is done by setting the order status to “Canceled”. You can also set the delivery status and the
payment status to “Canceled”, but only setting the order status will reset the stock level and thus
effectively cancel the order.

 

Items

Here you have the possibility to see the individual items of this order, as well as the calculation of the sum
of the items.
You can also add new products as positions, edit existing ones or remove them. The price, the quantity and
the tax rate can be customized.

 
 

Delete (1): To remove items, select on the left-hand side. A Delete button will then appear above the
table to remove the selected items. 
Add product (2): Here, you have the option of adding an existing product via a drop-down menu. 
Add empty item (3): Here, you can add an item. Instead of the drop-down menu, you can enter a name
for the item yourself and then enter your own price and tax rate. 
Add credit note (4): Here, you also add an empty item and give it a name yourself. However, you enter a
negative amount as the gross price. The tax rate is initially automatically based on the tax rates that
already exist in the order. If there are products with different tax rates in the order, auto is entered here
and the tax rate is taken from the product that was added first. 
Show product (5): This takes you to the configuration page of the respective product.

Depending on your configurations, the items in the order can also have different taxes and are calculated
here individually to form a total price.
This allows you to offer mixed baskets for your customers.

Details

In the tab Details you will find detailed information about the order, payment and delivery.

Payment



In the payment section you will see all the payment information for your order.

 
 

Payment status (1): Here, you can see the current payment status of the order. If there have already
been changes to the history, you can display the complete history via the "Show status history" link.  
Some statuses are interdependent and can only be selected if the order already has a certain status.
For example, the payment status Refunded, Partially refunded or Chargeback can only be assigned if the
order previously had the payment status Paid or Partially paid. 
Billing address (2): Here, you can change the billing address of this order. This does not change the
customer's standard billing address.  
Payment method (3): Here you can see the shipping method selected by the customer.

Shipping

Here you will be given all the details for the delivery of the order.
These include the shipping method, the delivery date, the shipping costs and the address to which the
order is to be delivered.

 

Delivery status (1): Here, you can see the current delivery status of the order. If there have already been
changes to the history, you can display the complete history via the "Show status history" link.  
Some statuses are interdependent and can only be selected if the order already has a certain status.
For example, the delivery status can only be set to Returned or Partially returned if the order previously
had the delivery status Shipped or Partially shipped. 
Delivery details (2): Here you will find all delivery details such as the delivery address, the selected
shipping method, the shipping costs and the planned delivery date. Here you can change the delivery
address of this order. The customer's standard delivery address and billing address will not be changed. 
Shipment number(s) (3): Here, you can enter any tracking codes of the shipping service provider. The



customer will see this number in their customer account in the details of the respective order.

Order

In the shipping section, you will find all general information about your order.

Order status (1): Here, you can see the current delivery status of the order. If there have already been
changes to the history, you can display the complete history via the "Show status history" link.  
Some statuses are interdependent and can only be selected if the order already has a certain status.
The order status can only be set to Completed if the status has already been set to In progress. To change
it back to Open, the order status must first be set to Completed or Canceled.
Order details (2): The customer's e-mail address and telephone number are displayed here, as well as
the sales channel through which the order came in and the order language. You can subsequently change
the e-mail address and telephone number. All status mails will then use the new e-mail address for the
delivery of e-mails. The default e-mail address of the customer account will not be changed.  
Affiliate code and campaign code (3): If the customer has ordered something via an affiliate code or
campaign code, these are displayed here. These can also be changed at a later date. 
Additional information (4): If the customer has left a comment on the checkout page, this is displayed
here and can be changed. 
Discount promotions (5): Any discount promotions used for this order are displayed here. 
Deactivate automatically added promotions (6): This setting prevents promotions from being
automatically added to the order when creating or editing an order. These can be currently active
discounts, for example.

Documents

The document templates are managed within the document module, in your settings.
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After you have clicked on Create New you can select which type of document you want to create for this
order. To create the document you have to make the following settings:

Number and date (1): Enter here the number of the document and the date, which should be entered on
the document. This information is necessary if you create the documents with Shopware. By default, the
next number from the respective number range is selected as the number.
Upload custom document (2): If you don't want to create the documents like invoices or delivery bills
with Shopware but the documents are already available as PDF, activate this option. In a further step you
have the possibility to upload this PDF. In this case, the input number and date will not be reproduced on
the document.
Comment (3): The comment is noted in the standard at the bottom of the document. 
Preview (4): With this button you can see in the browser how the document created by Shopware would
look like. Own documents are not considered here.

When creating documents, their dependencies must be taken into account. Partial cancellations,
cancellation invoices, and credit notes can only be generated if a corresponding invoice has been created
beforehand, as these documents each reference the associated invoice.

After creating a document, you can send it as an attachment by e-mail.



To do this, simply click on the checkbox in the Attach column. Sending the email to customers is
automatically activated, but can be deactivated using the switch if required.

Your customer will then receive an email with the corresponding document/receipt.

The document is also made available as an accessible HTML version in the e-mail. To do this, your
customer must click on the automatically sent link and log in.



The content of the document is then displayed in the browser window as an HTML version.

E-Invoices in ZUGFeRD Format

Since January 1, 2025, the issuance of electronic invoices for domestic B2B transactions in Germany has
been mandatory. To facilitate the seamless implementation of this legal requirement, Shopware has
supported E-invoices in the ZUGFeRD format since version 6.6.10.0.

With this feature, invoice data can either be provided as a separate XML file or directly embedded into the
familiar PDF invoice document. The latter offers a particularly convenient solution, as it allows you to
maintain your existing processes while also complying with the EU standard EN 16931.

You can choose between a usual invoice or an Invoice: PDF with an embedded ZUGFeRD e-invoice or
an Invoice: ZUGFeRD e-invoice when creating the document.



You set the basis for the e-invoice information with the settings for the standard invoice. The values
entered there in the fields for the business settings are used for the e-invoice.

Shopware uses the CII standard for e-invoices, which is integrated in the ZUGFeRD format. This enables the
creation of hybrid invoices that are both machine-readable (XML) and human-readable (PDF).

You can add the ZUGFeRD e-invoice to the document creation flow so that it is generated automatically.

https://docs.shopware.com/en/shopware-6-en/settings/Flow-Builder


Bulk edit

 

Bulk edit offers you an easy and quick way to change multiple orders at the same time.

You can select individual orders (1) or all orders that are displayed on this page (2), you have the
option to select orders on multiple pages. The maximum orders that can be selected at once are 1000. The
number of currently selected orders (3) is displayed in above the orders. The option to deselect all
orders (4) is only shown if you have selected products from multiple pages. To edit the selected orders
click bulk edit (5).

After clicking bulk edit, a modal will popup will show you the orders you have selected.

In this overview, you have the option to remove orders from your current selection. Once you are satisfied
with your selection click start bulk edit.

Status



(1) Payment status: Select this option to change the payment status of the orders.
(2) Delivery status: Select this option to change the delivery status of the orders.
(3) Order status: Select this option to change the order status of the orders.
(4) Send: status emails: as soon as you change at least one status (payment, delivery or order status),
you can decide whether the customer should receive an email about the status change.

If this option is deactivated, no more emails will be sent. This is relevant if you have defined a flow that
sends emails and is triggered, for example, by the bulk edit of a status. In general: If the option is
deactivated, no more emails will be sent via the flow, even if it can still be executed.

(5) Send: Documents: This option is available as soon as the previous option (4) is activated.
Here you can now select whether the customer should also receive a document in addition to the status e-
mail. If documents already exist, they are automatically sent to the customer as an attachment in the
status e-mail. However, it is important that only the most recent receipt is used. So, if you create a receipt
by changing the Merfach, this is the one that will be sent. Regardless of whether there is already another
receipt.
You can use the checkbox "Skip already sent documents" to prevent the customer from receiving a
duplicate document.

Please note that you can only change the order status to a status that is valid for all selected orders.
e.g. An order with the status open can be changed to in progress and cancelled, an order with the status in
progress can be changed to done and cancelled. If you select an open and in progress order you can only
change these to cancelled since this is the only status that is valid for both orders.

Status Transitions

Order Status



Delivery Status

Generate documents

With the bulk edit you can create documents for the selected orders. It is also possible to create several
documents at once. However, if a document already exists, it will not be created again using the bulk edit
function.
Invoice

To create an invoice, you must select a date. Optionally, you can also enter a comment.
In addition, the value of the corresponding number range is increased when the invoice is created. This
happens automatically, so you do not have to make any further entries here.

Storno bill



In the case of a cancellation invoice, the value of the corresponding number range is also automatically
increased. Here, too, you do not have to enter a manual invoice number because the last reference invoice
number is always used.
You can also enter a date and a comment.

Delivery note

For the delivery note, the value of the corresponding number range is also automatically increased. You
can also enter a date and a comment.

Credit note

This document is only created if there is a credit note item in the order.
Similar to the other documents, the value of the corresponding number range is increased for the credit
note. You can also enter a date and a comment.

Download

You can download the documents via this option. It is not even necessary to create new documents via
bulk edit. In this case, the most current documents of the order are always used.
You can download the documents after you have made the bulk edit. The individual documents are



provided in a merged PDF file.

Apply changes

A popup will show you the number of items that are about to be changed, confirm this by clicking apply
changes.



Trigger Flows with this bulk edit
If you send status emails with your multiple changes, it can happen that all triggers created in the Flow
Builder are executed for all changes of this multiple change. Under certain circumstances, this can lead to
flows being executed twice.  You can prevent this with the Trigger Flows option (1).

After successfully making bulk edit, the following message appears. If you have activated the download
function before, you can download the documents as PDF as described.

The payment process in Shopware 6

In Shopware 6 the payment and the order are completely separated from each other. This means that,
unlike in Shopware 5, an order is triggered as soon as the customer clicks on Send order.

The payment status then remains open for the time being. As soon as the customer has made the
payment, the payment status changes to Paid. Usually, the customer makes this payment (for example, if
he is redirected to PayPal) immediately after the order process.

Should the payment process be aborted by the customer or an error occur, the customer can also initiate
the payment again in his customer account at a later date or change the payment method.

The customer can see his order, including the delivery status and the payment status in the order overview
of his account.



Change payment method (1): This option takes the customer back to the checkout page of the order,
where he can update the payment method and carry out the payment process again.

Repeat order (2): Here, the customer can place the order again. When this option is clicked, a new
shopping cart will be created with the products in the corresponding order. The shopping cart can also be
edited afterwards (e.g. payment or shipping method). In the end, the order must be placed manually as
usual by clicking on the order button.

Cancel order (3): The customer can cancel the order completely. To allow the customer to cancel an
order, it is necessary to activate this option& in the admin under Settings > Cart settings > Enable refunds.

Orders without customer account

In the checkout, a customer may also choose to place an order without creating a customer account by
ticking the checkbox. Registered customers have the option to view and edit their orders in their customer
account under the item Orders.
Unlike orders placed by a registered customer, customers who place a guest order without registering
cannot log in to their customer account and thus have no way to view their order again.
Therefore, in the order confirmation email, they will receive a link to view their order.

After the customer has authenticated himself with his e-mail address and postal code, he has access to his
placed order and can make changes there.

After Order Payment Process

In Shopware 6, payment and ordering are completely separate. This means that, unlike in Shopware 5, an
order is triggered as soon as the customer clicks on Submit payment in the checkout.



Settings

In the settings of your administration you have the possibility to configure the event actions, which for
example should occur after an order without payment and the display in the shopping cart.

Flow Builder

To configure individual settings for the different actions/business processes, you have the possibility to
combine triggers (e.g. certain order/payment state) with rules (e.g. payment methods) and e.g. email
templates to so-called flows, which are then triggered by these triggers. Yo can find them in the
administration at Settings > Flow Builder. In the overview you will see a list with the predefined flows.

Active (1): In this column you can see which flows are enabled or disabled.

Name (2): In the Name column you will find the corresponding flow, which will be triggered after activation
and if the trigger applies. This is a required field if you create a new flow using the Add Flow (6) button.

Trigger (3): This column shows which trigger is used for the flow. This field is also required when you add
a new flow.

Description (4): For each flow, you can specify a description in addition to the name if you would like to
differentiate more easily between the flows.

Flow-Options (5): Using the three-point menu, you can edit or delete an existing flow.

Add Flow (6): Using this button you can add new flows.



When you edit or create new flows, you can specify a name, description and the priority in the General tab
(1). You can also activate or deactivate the flow here. You can then configure the flow itself by switching to
the tab Flow (2).

First you have to select the trigger (1) of the flow. This can be, for example, reaching a specific state.
Then you can add a condition (2) based on a rule from the Rule Builder, which triggers one or more
actions if the condition is true or if the condition is false. The condition can also be skipped, so that the
trigger directly executes an action.



For actions where a mail template is to be sent, you can also specify who the recipient of this mail should
be. Here you have the choice between the following options:

Standard: The recipients provided by the system (customer or shop owner).

Admin: All users marked as administrator

Custom: Any email addresses

Shopping cart

If you want to allow your customers to cancel their order afterwards, for example after a payment
cancellation, you can configure this function in the Settings > Cart settings. Activate the option Enable
refunds.

The payment process



Order overview

As soon as an unpaid order with a payment method such as PayPal is available, you will see it in the order
overview with the payment status "failed". This does not mean that there is a technical problem with the
PayPal extension, but that the customer has not yet made the payment. This can be the case if the
customer deliberately cancels the payment or there is a discrepancy with the customer's PayPal account.

After Order Payment Process in case of cancelled payment

This occurs when a payment fails. As soon as this is the case, the customer is again given the option to
complete his payment with another payment method. The background to this is that the order and the
payment are detached from each other. The order is therefore received by the system despite the failed
payment. Only the payment status remains "Open". The customer can continue with the selection of
another payment method and does not have to worry that the entire order has been canceled.

To make this process more transparent, here is a simplified diagram of the technical process.

View in the Storefront

If an order has been placed but not paid for, the customer will first receive a notification that the payment
process has failed. If the customer now clicks on the link Change payment, the order will be made
available again in the checkout process. Here, the customer has the option of using the same payment
method again or changing it to another payment method.



In this overview, the customer not only has the possibility to complete the order but also to cancel it.
However, the option to cancel the order is only available if you have activated this option in the
administration under Settings > Cart settings > Enable refunds.

The customer has another possibility to restart the payment process within his account.

The customer can either repeat the order by clicking on the red button Complete payment or by clicking
on Repeat order in the context menu. The payment method can also be changed again by clicking on this
button.
If the option to cancel is activated in the settings, the customer can also cancel his order at this point.



As long as the order has not been set to the status "paid", a change of payment method can still take place
or the payment can still be completed. Once the status "paid" has been reached, the order can only be
cancelled by the customer.

Returns management

General

With the returns management, you can process returns that you receive from your customers directly in
the admin. As a merchant, you can create a new return based on an existing order.

The returns management is available to you as of the Shopware Rise plan via the Shopware Commercial
extension.

Create a return

To create a return, you must open an existing order. In the next step, under the General tab, select the
items of the order that you have received as a return and then select the new item Return items.

Please note that currently only one return can be created per order. In addition, there is currently no
automatic stock calculation. This must be done manually.



A window will open with an overview of the items you have selected. Here you can specify the Return
quantity and enter an additional Comment. The return is triggered by clicking the Add to return button.

Within the order, a new Returns tab has appeared, in which you can find all the details of the return you
have just created and can also edit it further.

Edit return

Under General, you can set the overall return status and add comments. 



In the Positions section, you can edit individual return items. If needed, you can adjust the return quantity
afterwards, assign a status, or remove the item from the return. You can also edit the shipping costs by
double-clicking the corresponding field.

You also have the option to view the corresponding product or modify the return amount.

A new document, the so-called Partial cancellation, can then be created under the tab Documents. This
type of document is only available if an invoice has already been created.

From the time a return is created, your customers can view it in the customer account within the order
overview. The return status you have assigned is displayed there for the customer.

Want to dive deeper?
You’ll find an interactive learning path on this topic in the Community Hub. Explore it step by step, try out
features directly, and grow your knowledge in a playful, hands-on way. 

https://hub.shopware.com/learn/unit/user-returns-management


Customers

In this section, we take a closer look at the customer overview and the creation of new customers.
You will also get a detailed overview of the associated functions and what you need to bear in mind here.

Customer Overview

The customer module allows you a comfortable administration of your customer base.
Here you get a view on all relevant data of your customers and various possibilities to edit them.

Within the customer overview you can manage your customer base.

You also have a direct view of all your customers, can search for them (1), view them in detail (2),
edit them (3) and delete them (4).
You can also add a new customer to your system via the button Add customer (5). On the right side you
will find tools (6) to update the overview and to narrow it down further by filter settings.
The Created by admin (7) badge tells you that the customer is a manually created customer. This can be
the case, for example, when customers want to order by phone.

Customer ID:
The internally assigned customer number of your customer.

Name, address, email: 
Here it concerns deposited address data, as well as the name of your customer.
These can be found in many steps concerning this customer.

The address always displays the currently assigned standard billing address of the customer.

View a customer

A click within the context menu on View (1) to the right of the customer opens a detailed overview.
You will find all data of your customer in a structured overview in this mask.



General

The General tab (1) shows you more detailed information about your customer.
This also includes the data that can already be seen in the overview. You can use the Log in as customer
button (2) to log in to the storefront as your customer. As soon as you have clicked on the button, a pop-
up will appear in which you can select the desired sales channel for login. This gives you the option of
placing orders for your customers or viewing the data in the customer's account. 

Addresses

The addresses tab shows all the addresses stored for your customer.
Similar to the customer overview, you can find structured information about the customer's addresses
here.



In addition to the possibility to specify the standard delivery address (1) and standard billing
address (2) by clicking, you will also find a search (3) and the possibility to add a new address for the
customer (4).
If you click on the button (5), the context menu opens, which now also gives you the opportunity to edit
the address, or you can duplicate or delete it.

Orders

In the tab orders you an overview of all transacted orders of your customer is indicated.
Here you will find relevant information about the order number, the amount, the order status and the order
date. We also offer a search function (1).

By clicking on the field (2) you have the possibility to open the corresponding order and land in the order
details.

Company

From Shopware version 6.5.6.0 and the Evolve plan, it is possible to use the employee management. This
allows you to create employees and assign roles to them. In order for the Company tab to be available for
the respective customer, the employee management must be activated in the customer's edit mode.

You can invite a new employee to the company by clicking the Add employee account button (1). For
this purpose, the first name, last name and e-mail address must be entered. The role is optional. In the
overview, you can check the status of each employee. After the invitation has been accepted within 2

http://docs.shopware.com/en/shopware-6-en/orders/overview#order-details
http://docs.shopware.com/en/shopware-6-en/orders/overview#order-details


hours, the employee is part of the organization. Via the three points, you can deactivate it if necessary.

You can create a role via the button Add role (2).

First, you enter the name (1) for the role. You can also decide whether this role should be used as the
default role for new employees (2).  Furthermore, you can set the permissions (3) for the employee
here. These are limited to the areas of employee management, role management and orders.
 

In the frontend, the respective employee can also create roles and manage employees. To do this, first log
in and go to the your account icon (1). Here you can then go to the respective employee management



(2) or to the role management (3). The configurations here are the same as in the admin.

Edit a customer

The edit mode lets you configure the General tab.

This includes all the information you could already see within the General tab.
You can also configure a standard delivery address and a standard billing address in this mode.
You can find the option here in the General tab below under Addresses.

Create a new customer

Within the customer module you have the option to create a new customer.



The module allows you to enter common entries for the newly created customer (name, address, etc.).
It is possible to assign a customer group directly to the customer (1). This applies e.g. given settings
of this customer group to this customer.
The field Sales channel (2) lets you assign the customer to one of your sales channels and thus
determines how far he sees your storefront and which products he gets, for example, played out.
The field Tags (3) allows you to assign various keywords to the customer, which you can use in listings,
product streams or rulebuilder to allow further nesting within a customer group.

Further you have the possibility to assign an address directly to the customer in advance in the submenu
Addresses here.
The red marked fields are mandatory fields, which have to be filled in by you, so that you can create this
customer.

Customer Overview (Storefront)

Overview

This section provides you with a general overview of your data. Similar to a dashboard, it gives you a quick
and concise view of your orders, addresses, and other relevant information.

Your Profile

In the "Your Profile" section, you can change your login information, such as your email address and
password. This allows you to have control over your login credentials and adjust them as needed.

Addresses

Under "Addresses," you can manage your stored addresses. Here, you can edit, delete, or add new
addresses, ensuring that your deliveries always go to the correct address.

Orders

In the "Orders" section, you can view all your past orders and check their current status. Using the three-
dot option, you can repeat orders or, if a payment is still pending, change the payment status. This helps
you keep track of your purchases and make adjustments when necessary.



Subscriptions

Here, all your subscriptions are displayed.

Quick order function

Starting with Shopware version 6.5.4.0 and the Shopware Evolve plan, it is possible to use the quick order
function.
This allows your customers to speed up the ordering process by adding items to the shopping cart via item
number or CSV file.

Activation

The function can be activated per customer by first entering the edit mode and then setting the "Quick
order" function to active.

Frontend view



In the frontend, you can access the feature by clicking on the account icon (1) and then selecting Quick
Orders (2).

To speed up the general ordering process, you can search for products by name or number (1) and
adjust the quantity (2) directly. 
Alternatively, you can upload a CSV file (3). After clicking on the button a window will open where you can
upload your file. The file must contain the columns "product_number" and "quantity". You can also
download a sample file there. As soon as all products are selected, you can add them to the shopping
cart (4). If you want to delete the list, you can do this with the button "Clear list" (5).

Bulk edit

Bulk edit offers you a quick and easy way to change multiple customer records at the same time.

You can select individual customers (2) or all customers (1) displayed on this page. You can also
select customers on several pages. The number of currently selected customers (3) is displayed above
the customer overview. To edit the selected customers click on Bulk edit (4), to delete all selected
customers click on Delete (5).

After clicking on Bulk edit, a modal will pop up and the selected customers will be shown.

In this overview you have the option to remove customers from your current selection. Once you are
satisfied with your selection click on Start bulk edit.



Mark the checkbox (1) of the items you want to change and update the values (2). Click Apply changes
(3) to proceed. Please note that only values will be changed where the checkbox is ticked.

The data to be edited is divided into blocks, e.g. account, tags, etc., as in the individual configuration of a
customer.

In some blocks in which it is reasonable an additional dropdown with different options is available. This
option defines the way in which the changes in this block are to be handled.

Overwrite: If you select this option, the previous data/settings will be overwritten by the selection you
have now made..
Clear: This option removes all data/settings from this block.
Add: This option only adds the data/settings entered here to the customers. Existing settings will not be
removed.t.
Remove: This option removes the data/settings entered here from the customers, if they were already
applied to the customer records.



A modal will show you the number of customers which are to be changed. You have to confirm this by
clicking on Apply changes.

Please wait while the system is updating the customer data/settings.



Shopware will inform you once it's done with the task. Click Close to exit and return to the overview.
 

AI-generated Customer Classification

AI-generated customer classification is available to you from the Shopware Rise plan.

With this function you have the possibility to create an automatic AI supported classification of customers,
which you can use in a further step for example for mailings or other marketing actions. 
The classifications are saved as tags on the customer and can also be used for other functions within
Shopware.

To start the classification of customers, first select all customers in the customer overview that are to be
included in the automatic classification and then click on Classify (1).



Afterwards a window opens, with which you can carry out the classification.
In the field Generate content (1) you can optionally add further information to your classification. This
can be the purpose of the classification, the marketing campaign for which it is to be used or the evaluation
reason. The AI will then create automatic classifications based on this field and the selected customer data.
You can also optionally leave this field completely blank. Then the AI works only with the data from the
customer accounts.   
In the field Number of tags (2) you specify how many classifications and therefore tags should be
created.   
With the Generate tags button (3) you start the classification.

After generation, the generated tags with generated names (1) are displayed in a list. For each tag, a
description (2) is also created that roughly explains which customers are considered by this classification
and a condition (3) that breaks down in detail according to which conditions the tags are assigned.

With the context menu (4) you can manually adjust the tags.  
To assign the tags to the customers, select the tags you want to assign and click Start (5). 
The selected tags will then be assigned to the customers that match the respective conditions. Of course, it



can happen that not all initially selected customers will be assigned the tag, but only those that meet the
corresponding conditions. 

If you perform a new classification at a later time, all AI-generated tags from previous classifications will be
removed from the customers and the tags themselves will be deleted.

Customeraccount

Overview

This section provides customers with a general overview of their data. Similar to a dashboard, it offers a
quick and brief summary of orders, addresses, and other relevant information. In the form, customers can
also sign up for the newsletter. You can find more information about the newsletter here.

Personal Profile

In the "Personal Profile" section, you can change your login details such as email address and password.
This way, you have control over your login information and can adjust it as needed.

https://docs.shopware.com/en/shopware-6-en/settingsNewsletter-configuration


Addresses

Under "Addresses," you can manage your saved addresses. Here, you can edit, delete, or add new
addresses. This ensures that your deliveries always go to the correct address.

Orders

In the "Orders" section, you can view all your placed orders and check their current processing status.
Through the three-dot option, you can repeat orders or, if the payment is still pending, change the payment
status. This makes it easy for you to keep track of your purchases and make adjustments if necessary.



Subscriptions

In this section, you can create subscriptions with recurring orders and configurable intervals.
"Subscriptions" is a versatile tool that allows merchants to leverage the growing trend of subscription
models in e-commerce.

For more information, click here.

The subscription feature is available from version 6.5.4.0.
It is available as a commercial feature starting from the Beyond plan.



Content

In this section, we take a closer look at the experience worlds, themes and media.
You will also get a detailed overview of the associated functions and what you need to bear in mind here.

CMS extensions for Shopware 6

The CMS Extensions for Shopware 6 is an extension that is part of Shopware Evolve and provides extended
functions for the shopping experiences.

Installation

If at least the Shopware Evolve plan is stored for the store domain in the Shopware account, you can
download and install the extension under Extensions > My Extensions.
It is important that you have previously logged in with your account in the Shopware Account tab. 
After the extension has been installed, you can activate it using the button to the left of the extension.

Functions

The following functions are provided by the extension:

Quickview

This function enables a product view directly in the listing.
This means that the customer does not have to leave the Listing to get a more detailed overview of the
product.

Activation
The activation of the function is possible in the respective shopping experience and is available for the
following elements of the commerce type: "Three Columns, Product Boxes", "Product Slider" and "Cross
Selling".
If you have selected a corresponding element in the shopping experience editor, you can activate
quickview (1) under item behavior.
This will then be used in all categories to which this shopping experience is assigned.



Frontend view

Quickview in search results

You can also activate this product view for the search results.

Activation
This function can be activated directly in the configuration of the extension. To do this, go to your
extensions in the administration and open the configuration of the CMS extension using the three dots on
the right-hand side. You can then activate and save the function.

Frontend view



Scroll Navigation

The scroll navigation provides you with the opportunity to set navigation points in an shopping experience.
Based on these navigation points, a navigation menu is displayed on the left side, which allows you to jump
directly to the individual sections. In addition, the sections can be accessed directly by using the URL
parameters.

Activation
A navigation point can be created for each section in the shopping experience. For this purpose the
extension provides a new section Scroll Navigation in the section settings.

To assign a navigation point, first open the section settings using the symbol on the left side of the
section (1). On the right side you can now unfold the configuration of the Scroll Navigation (2). There
you can activate the navigation point (3) and assign a name (4). If the navigation point is activated,
an additional symbol is shown on the left side (5). This allows you to see directly whether the
navigation point is active for a section.

We recommend that the individual section should at least fill the screen, using a smaller section could lead
to inaccurate jumping to the desired section.

Animated scrolling
This function will enable animated scrolling when jumping to a navigation point.
If at least one navigation point is set in a shopping experiences, animated scrolling (2) can be activated
in the settings of the shopping experiences (accessible through the gearwheel symbol) in the item Scroll
navigation (1).



For individualisation you can choose from different scroll behaviours (3) and set an animation duration
(4). Besides the scroll behaviour constant (linear) there are other settings (5) available.
The elastic scrolling (6) is an animation, which lets the picture "jump" a little bit before and after the
scrolling process.
Alternatively you can adjust the degree of the course curve (7). This value controls the acceleration or
deceleration of the scrolling (not with constant (linear) or active elastic scrolling).

Frontend view - desktop

The navigation bar (1) is located on the left side to get to the individual navigation points.
If you use the mouse pointer to hover over one of the navigation points, the name of the section will be
displayed.

Frontend view - Mobile



In the mobile view, the navigation menu is located at the bottom right.
With the arrow button (1) you can jump between the individual navigation points.
Use the button with the 3 dashes (2) to expand the menu.

In the expanded overview (1), the individual sections are now listed with their respective names.



Call by URL parameter
It is possible to call up a navigation point directly from a URL parameter. The name of the navigation point
is used for this.
In our example, the name of the navigation point is "Lorem Ipsum". The call is made using the URL
https://your-shop.com/Test-Landingpage/#lorem%20ipsum

Define visibility of individual blocks

The extension provides a function to control the visibility of individual blocks of a CMS page using the rule
builder rules.

Block (1): To change the settings select the desired block.

Block settings (2): This opens the block settings on the right side.

Visibility (3): Define the visibility of the block.

Rule builder rule (4): By default the block is always visibile, Select a rule to define
when the block will be hidden.

Visible, if rule does not apply (5): If this is active the set rule will be reversed.

Individual forms

In addition to the default form, you can also add your own individual forms to the shopping experience with
the CMS extension for Shopware 6.

To add a form to your shopping experience, click on Content > shopping experience and select the
shopping experience to which the form is to be added. Then click on the + symbol to add a new block and
select form as the block category. In addition to the default form, e.g. for the contact, you can now also
drag your own form into your shopping experience.

https://docs.shopware.com/en/shopware-6-en/settings/rules
https://docs.shopware.com/en/shopware-6-en/settings/rules


A pop-up window opens, this gives you the option to use a previously created template or to create a new
form.

Even if you use a template, you can still edit it completely afterwards.

Options

When you create a new form or edit an existing one, the form settings window opens with the tabs
options and fields. The basic settings for the form are made in the options tab.

Name (internal) (1): Enter the internal name of the form. For example, if you save the
form in the templates, this name will be used.

Headline (2): The headline is used in the shopping experience, i.e. in the frontend, as
the headline for the form.

Confirmation text (3): The confirmation text is displayed to the user as soon as he has
filled in the form.



Recipient address (4): Enter all e-mail addresses to which the filled out form should be
sent. Multiple addresses can be entered simply by pressing the Enter key once after
each address.

E-mail template (5): Select the e-mail template to be used for sending the form
content to the recipient addresses.

Fields

In the Fields tab you can specify which fields can or must be filled in by the user. To do this, you can create
groups that contain one or more fields.

Group (1): On the left side you see the groups of the form. You can use the dots on the
left to change the order of the groups by drag and drop.

Group context menu (2): On the right side of each group you can rearrange its
position, delete it or duplicate it. You can also edit the group so that further options for
the group are displayed on the right-hand side of the screen. Here you can enter the
internal name of the group and you can change the heading of the group. The heading is
also displayed in the frontend.

Field (3): The fields are located within a group. You can change the order of the fields
within the group by drag and drop using the dots on the left.

Field context menu (4) on the right side of the field, you can rearrange its position of
the field, move the field to another group, duplicate it or delete it. You can also edit the
field there so that further options for the field are displayed on the right side of the
screen.

Add field (5): Adds a new field within the respective group.



Add group (6): Use this button to add a new group including a field.

Options (7): Depending on whether you are currently editing a group or a field, you will
find further options for the respective group or field on the right-hand side.
If you are editing a group, you will see the information Name (Internal) and Heading. The
heading is visible in the frontend, while the internal name serves as an internal
identification. E.g. as a variable in e-mail templates.
You can see which options are displayed here when you edit a field.

Save as template (8): With this button you can save the form you have just created as
a template. These templates can be edited and selected in your shopping experience.

Done (9): To save all changes in the current form, click on done.

Field options

When you edit fields, you will see the options you can edit on the right hand side. The possible options
differ depending on the type of field you are editing. However, the following options are always available
for each type.



Name (1): The Internal Name serves as a unique identification for the use of this field as
a variable. E.g. in e-mail templates.

Title (2): This name is displayed on the form in the frontend.

Type: (3): Select the type that the field should have. This type determines which values
can be entered in the field and how they should look. We have listed the available types
below.

Width (4): Here you define how wide a field should be. If two subsequent fields together
use a maximum of 100% of the width, they are displayed next to each other in the form.
This is useful, for example, if information is to be entered in two fields, but the content
belongs together. E.g. street name and house number.

Required field (5): Indicates whether the field is mandatory or not.

Error message (6): This message is displayed to the user in the frontend if a
mandatory field has not been filled in.

Text field & email field

For the field type Text or E-mail, you can specify a placeholder text to be displayed if the field has not yet
been filled in.

Number field

For fields with the type number, you can optionally specify whether there should be a minimum or
maximum limit. You can also specify the steps in which the user can enter numbers. If you enter a 3 here,
for example, the user can only select numbers 3, 6, 9, 12, 15, etc....

Selection field



The selection field is a checkbox that the user can activate or deactivate. In the default value you can
specify whether the field should already be activated by default or not.

Selection

The selection type offers the user a predefined selection to choose from. Using content = entity, lets
you select in the second step, from which shop entity the user can make a selection.
Using content = user-defined, lets you enter values in the second step, from which the user can then
choose. Type the values into the field values and press the enter key.

Text area



The text area is used to enter a longer text. In addition to the placeholder text, you can also specify how
many lines the user may use and whether the user may change the size of the text area.

Shopping Experiences

The Shopping Experiences are found under Content. With Shopping Experiences, you can create content
pages such as landing pages, shop pages and category layouts and manage them centrally. 
The created layouts consist of sections in which individual blocks are added, which in turn consist of one
or more elements such as text or images.

You can find a tutorial for designing your store here.

Further functions for the Shopping experience are provided by the CMS extension, that is available from
Shopware Evolve onwards.

Overview

The overview lists (1) all layouts already created. In the search box (2) you can search for a created
layout. You can use the drop down menu Sort by: (3) to sort the list by creation date or editing date.
In the menu called Layouts (4) on the left side, you can filter the layouts thematically. For example, here
you can limit the display to all shop pages or all landing pages.
Using the context menu (5) in each entry, you can delete, duplicate or preview the respective layout.
This preview only has the purpose to make it easier to distinguish between the layouts in this overview. 

With the button Create new Layout (6) you can create a new layout.

To edit a layout, just click on the corresponding entry.

Creating a New Layout

https://docs.shopware.com/en/shopware-6-en/tutorials-and-faq/how-to-design-my-homepage?category=shopware-6-en/tutorials-and-faq
https://docs.shopware.com/en/shopware-6-en/extensions/cms-extensions


When creating a new layout, some points for the configuration are first defined using a step-by-step query.

Layout Type

After you click Create new layout, you must define the page type for which you want to create a layout.
On the one hand, this serves to sort your layouts in the overview better. Furthermore, you can choose
between different blocks depending on the type. Currently, you can create shop pages, landing pages
and category pages.

Shop page:
All service pages of your shop are to be understood as shop pages. These include, for
example, the general terms and conditions page, the shipping conditions or the contact
form.

Landingpage:
Landing pages offer you a wide range of design and marketing options in your shop.
These can be theme pages, in which marketing can be done or other pages, on which
your customers can land during their visit to your shop.

Category page: 
The category page automatically includes a product listing.
Furthermore, you have the possibility to dynamically display texts from the
corresponding category on a category page. In the top right of the text element editor
use the Data mapping to choose the dynamically display text.

Product page: 
Each product has its own product page on which all information about this product can
be found and on which the product can be placed in the shopping basket. Some blocks
such as the product description or the buybox including the product image gallery are
already available as standard. However, the page can also be designed completely by
yourself. 

Section



Once you have decided on a type, you can choose how the section of the layout should be structured. You
can use a layout with a sidebar or alternatively the full page width.
The sidebar can be used to display the category navigation, filters or both.
During later editing you can add further sections, these may differ from the layout type that was initially
chosen.Once you have decided on a type, you can select how the section of the layout is to be constructed.
You can choose a layout with a sidebar or alternatively the full page width.

Name

On the following page you must assign a name for the layout that you are creating. Chose a name in a way
that it will reflect the purpose.

After completing the basic configuration steps, the layout editor opens.

Learning path availabe!
You’ll find an interactive learning path on this topic in the Community Hub. Explore it step by step, try out
features directly, and grow your knowledge in a playful, hands-on way. 

Layout Editor

You create new layouts and chance existing layouts in the layout editor.

https://hub.shopware.com/learn/unit/user-shopping-experiences


The central editing area (1) is used for editing your layout.
On the right side is the menu bar, which you can use to call up the individual functions for editing. These
are divided into the areas Settings (2), Blocks (3) and Navigator (5). Depending on whether you have
clicked on a specific block or the entire section (9), you can access the block settings or the section
settings (4). Via Layout Assignment (6) you can set which category or landing page the layout will be
assigned to. The assignment can also be found in the settings of the respective category.

Detailed information can be found in the respective section below.
Using the + button (7) and (8) in the editor, you have the option to add another section. This section
does not have to use the same structure (with or without sidebar) as the already existing section.
Using the icons (9) in the bar at the top of the screen, you can switch between the individual viewports
and thus see how the layout is displayed in the different views. You can also switch to the list view of the
existing elements to fill the content of the elements more quickly without having to open each element
individually.

Settings



In the settings, you can change the layout name assigned during creation and, subsequently, the  Layout
type.

Blocks

In the menu item Blocks, various predefined blocks are available, grouped according to categories, which
you can select using the drop-down menu. The blocks contain one or more elements that can be
individually filled with content. 

 

Add Blocks



You can drag and drop them into the editor and place them in the desired position.

Populate an element with content

To adjust the content of an element within a block, move the mouse over the element in the preview. This
will display two symbols in the upper right corner of the element. The gear symbol (1) opens a new
window where you can define the element's content.
You can use the symbol with the two arrows (2) to change the element, e.g. a text element with an
image.

There are different settings depending on the block you want to edit.

Text

Text blocks are blocks that contain only text. These are available in different formats.

A text editor is available to customise the text in the settings of a text element. If you have chosen
Category Page as layout type, the data mapping is available on the right side above the editor. Here,
you can select dynamic category texts, such as the category description, which are then displayed in this



element.

For category and product pages, you can also include variables (1). This allows you to access and
integrate category or product information directly into the text.

You can format the variables using the editor functions (e.g. bold). Note, however, that the formatting is
done for the complete variable including the curly brackets "{{ variable }}". Otherwise the variable will no
longer be correctly stored in the source code and cannot be replaced by the actual content.

The following feature is available to all customers with a commercial plan

AI Copilot

If you are looking for inspiration, you can have an artificial intelligence prescribe texts to you. You can then
either use these texts or adapt them to your needs.

You can open the AI Copilot (1) with the space bar if no text is available. You can select the desired text
and replace it with the AI Copilot (1) via the bar if there is already text.

https://www.shopware.com/en/pricing/


Insert link

Links can be inserted within a text block. As of version 6.4.10.0, these links can point to a fixed URL, a
product, a category, an e-mail address, or a phone number.

When linking to a product or category, the content page must be associated with the same sales channel
as the linked product or category. If you want to link to a product or category that is in a different sales
channel, you must use the "URL" linking type.

It is also important to note that adding a link only works if you write the text/word, select it and then add
the link.

Image

Image blocks contain only pictures. These blocks are available in different formats as well.

Image (1): First, you can change the image that is to be displayed. You can have the
image's content filled automatically with the item Data assignment. For instance, on a
product page, you can display the preview image of the product or the manufacturer. On
a category page, you can use the data assignment to display the category image of the
assigned category.



Generate image (2): Here you can access the AI-Copilot feature text to image. This
button is only a shortcut and will open the image generation in a new tab.
You can find more information about the text-to-image feature here.

Display mode (3): Here you decide how the image is to be displayed in the block. With
Standard, the image adapts to the surrounding box up to its native size. With Fill, the
box is completely filled with the image. With Stretch, the image is stretched to the size
of the box.

Vertical alignment (4): Specify here whether the image should be aligned to the top or
bottom edge or displayed in the center.

Horizontal alignment (5): Specify here wether the image should be aligned to the left
or right edge, or whether it should be displayed in the center.

Link type (6): Here you can select whether you want to add a URL, a product, a
category, an e-mail address or a telephone number to the link. 

Link to (7): Here, you can specify what you want to link to, either by entering a URL,
email address, or phone number or by selecting a category or product from a dropdown.
This can be done either in the same tab or in a new tab (8).

The image element does not have a size limit. However, you should generally ensure the image is not too
large for performance reasons. In the demo data, for example, we use a full-size image with a resolution of
1280x528px.
The standard template sets the image width to a maximum of 1320 pixels at full HD resolution (and higher)
and dynamically scales down at smaller resolutions.

In addition to the basic settings for most image elements explained here, you can make more in-depth
settings for sliders and galleries. These are explained below.

https://docs.shopware.com/en/shopware-6-en/content/media#ai-copilot-text-to-image


Slider

Display mode (1): Here, you specify how the images will be displayed.
Original: The images are scaled to the CMS page's width without any height
restrictions. The slider's height is dynamically adjusted.

Fixed height: The image is scaled to the CMS page's width without any height
restrictions. The slider keeps the height of the tallest image.

Cropped: The images are scaled to the current CMS page's width. Any vertical
overflow is cropped to the configured height.

Minimum height (2): This setting is only available for the "Original" and "Fixed height"
display modes. It is then necessary to make an entry, otherwise no images are
displayed. The entry is made in pixels as an integer and additionally "px" (as an
abbreviation for pixel) is added directly after the number. The entry could therefore look
like this: 500px.

Vertical align (3): This setting is available under the display modes "Original" and
"Fixed height" and specifies how the images are to be placed within the slider element.
For smaller images, corresponding free spaces are displayed.

Arrow navigation (4): Adds arrows to click through the images. You can define if the
arrows should be displayed on or next to the displayed image or if they should be
hidden.

Dots navigation (5): As an alternative (or in addition) to the arrow navigation, you can
use the dots navigation. This represents a small dot for each deposited image, which you



can use to call up the respective image directly. The display is possible on top of or
below the image.

Animation duration (6): The number stored here determines how fast the images
slide. The value is also given here in milliseconds.

Automatic transition (7): Here, you can set whether the image should automatically
slide.

Warning! Depending on the location of your shop, enabling this option may constitute a violation of
accessibility laws.

Delay (8): The number stored here determines how many seconds after the slider
begins to "slide". The number is given here in milliseconds.

Linking (9): For each image that you have uploaded to the slider, you can specify an
external link to which the image should lead when clicked. Additionally, you can use a
checkbox to determine whether the link should open in a new tab.

Open link in a new tab (10): Determines whether clicking on images opens them in a
new tab or uses the current tab.

Decorative images (11): For accessibility purposes, this option marks an image as
purely decorative, meaning it will not be detected by screen readers.

Gallery

Display mode (1): Here you specify how the images are to be displayed.
Original: The images are displayed in their original resolution or shrunk down to the
slider's height. 



Fixed height: The images are displayed in their original resolution or shrunk down to
the configured height. 

Cropped: The images are scaled to the current CMS page's width. Any vertical
overflow is cropped to the configured height.

Minimum height (2): This setting is only available for the Fill display mode. It is then
necessary to make an entry, otherwise no images are displayed. The entry is made in
pixels as an integer and additionally "px" (as an abbreviation for pixel) is added directly
after the number. The entry could therefore look like this: 500px.

Arrow navigation (3): Adds arrows to click through the images. You can define if the
arrows should be displayed on or next to the displayed image or if they should be
hidden.

Dots navigation (4): As an alternative (or in addition) to the arrow navigation, you can
use the dots navigation. This represents a small dot for each deposited image, which you
can use to call up the respective image directly.
The display is possible on top of or below the image.

Preview navigation (5): Specify whether the small images for the gallery preview
should be displayed to the left of the image or below it.

Zoom (6): If you activate this option, an enlarged representation of the image is
displayed when the shop visitor moves the mouse over the image.

Fullscreen gallery (7): Allows the gallery to be displayed in a full screen browser
window by clicking on the image.

Keep aspect ratio (8): The images are preserved without stretching or distorting and
are only scaled based on the longer side.

Show magnifier over Gallery (9): Displays the magnifying glass over the gallery
instead of next to it.

Commerce

In the commerce blocks you will find various product-specific blocks to offer and promote products in your
shop.

Product name & manufacturer logo

The product name & manufacturer logo block consists of a text block and an image block.If the shopping
experience is a product page, the text box is filled with the respective product name and the image block is
highlighted and linked with the manufacturer's logo.

Three columns, product boxes



Product (1): For each of the three products in this box, you can specify here which product should be
displayed here.

Layout type (2): This specifies how the product should be presented. You can display the product in the
default view, with a large image or with minimal text. 

Display mode (3): Here you specify how the images are to be displayed.

Standard: The image is displayed completely. The height of the entire slider element is
therefore dynamic and will automatically adjust accordingly. It is therefore
recommended that all images in the slider have the same aspect ratio, otherwise the
elements below the slider will "jump up and down".

Cover: The element is completely filled with the image. In the case of smaller images,
this results in them being stretched (and thus possibly appearing blurred). For images
with an unsuitable aspect ratio, the longer side is cut off, so the complete image is not
displayed.

Contain: The height of the element is automatically determined on the basis of the
highest deposited image. In contrast to the Standard mode, however, this is not adjusted
when switching between different images. You can define the alignment of lower images
using the item vertical alignment.

Vertical align (3): This setting is available under the display mode contain and specifies how the images
are to be placed within the slider element. For smaller images, corresponding free spaces are displayed.



Product slider

Display mode (1): Here you specify how the images are to be displayed.
Original: The images are scaled to the height or width of the product box, so that
they always fit into their designated area. The images are never scaled up. 

Fixed height: The images are scaled to the height or width of the product box, so
that they always fit into their designated area. The images can be scaled up. 

Cropped: The images are scaled to the height or width of the product box. Any
overflow is cropped. 

Minimum width (2): This value specifies the minimum width of the individual product
boxes.

Vertical align (3): This setting is available under the display mode contain and
specifies how the images are to be placed within the slider element. For smaller images,
corresponding free spaces are displayed.

Layout type (4): This specifies how the product should be presented. You can display
the product in the default view, with a large image or with minimal text.

Border (5): With this option you draw a frame around the slider to separate it from the
rest of the experience.

Arrow navigation (6): Here you can activate or deactivate the navigation arrows on
the sides.

Animation duration (7): The number stored here determines how fast the images
slide. The value is also given here in milliseconds.



Automatic transition (8): If you activate this option, the slider changes to the next
product every 5 seconds by default.

Warning! Depending on the location of your shop, enabling this option may constitute a violation of
accessibility laws.

Delay (9): The number stored here determines after how many seconds the slider
begins to "rotate". The number is given here in milliseconds.

Gallery and Buybox

The gallery and buybox blocks consist of a Gallery picture block and a Buybox. In the latter you can specify
the product to which the Buybox is to be linked and its exact position in relation to the Gallery block. If the
world of experience is a product page, the gallery and the buybox are automatically linked to the
respective assigned product.

Product description and review

This block contains the product description and the product review. In the element settings, you can assign
the respective product for which this block is to apply. If the experience is a product page, the block is
automatically linked to the assigned product.

Cross Selling

Content (1): In the content tab, you can specify the product from which the cross-selling products are
related. If the shopping experience is a product page, the cross-selling products automatically refer to the



product assigned by the product page.

Layout type (2): This specifies how the product should be presented. You can display the product in the
default view, with a large image or with minimal text. 

Display mode (3): Here you specify how the images are to be displayed.

Standard: The image is displayed completely. The height of the entire slider element is
therefore dynamic and will automatically adjust accordingly. It is therefore
recommended that all images in the slider have the same aspect ratio, otherwise the
elements below the slider will "jump up and down".

Cover: The element is completely filled with the image. In the case of smaller images,
this results in them being stretched (and thus possibly appearing blurred). For images
with an unsuitable aspect ratio, the longer side is cut off, so the complete image is not
displayed.

Contain: The height of the element is automatically determined on the basis of the
highest deposited image. In contrast to the Standard mode, however, this is not adjusted
when switching between different images. You can define the alignment of lower images
using the item vertical alignment.

Minimum width (4): This value specifies the minimum width of the individual product boxes. 

Video

In the Video block category, you can choose between three different video blocks:

Video

Youtube

Vimeo

Video



This block lets you select a video from your media or upload and embed a new one.

Note on playback options:

If you enable the Play automatically option, the Play muted option is automatically disabled and can no
longer be selected.
(This behaviour corresponds to common browser defaults and serves, among other things, to ensure
accessibility.)

If the Play automatically option is deactivated, the Load only after confirmation option is also
available.

Youtube



After you have created a video link, you can make some settings to determine how exactly the video
should be displayed. If you activate the advanced privacy mode, Youtube will not save any information
from visitors until they watch the video. In addition, you can choose exactly which part of the video should
be shown by selecting the start and end time.

Vimeo

For Vimeo videos you can also choose what color you want the navigation to appear in and what
information the video creator should display.



Sidebar

No separate settings are required for the sidebar blocks. They are automatically filled with content.

Form

For the form block you can first select the form to be displayed in the element settings. You can also enter
a title and a confirmation text.
On the Settings tab you can enter the recipient addresses that will receive the completed form.

The contact form is sent to the shop operator by e-mail after it has been filled in by a shop visitor. For this
e-mail there is a corresponding template in the e-mail templates with the name contact form, which can
be adapted.

HTML

https://docs.shopware.com/en/shopware-6-en/settings/email-templates


By integrating the HTML block, you can visualize all HTML representations in it. Please make sure that the
HTML Sanitizer is configured accordingly or deactivated, otherwise certain HTML tags or attributes may be
deleted.

3D-model

This feature is available from the commercial Plan Rise onwards. 

You can now add and display your 3D models in every layout.

3D models enable a more realistic and detailed product visualization than conventional 2D images.
Customers can view the product from different angles, zoom, and rotate, giving them a better idea of the
product.

It also allows you to convey more information about a product. Users can better understand details such as
structure, surface, and shape, which can lead to a more informed purchase decision.

You have the option of assigning 3D elements in the same way as the other blocks using the drag-and-drop
function. You then have the option of adding an image file. It is important to note that this must not be an
ordinary photo file. A 3D image file in .glb format is explicitly required.

https://docs.shopware.com/en/en/shopware-6-en/html-sanitizer


The .glb file represents a file format that is frequently used in the exchange of 3D models. It is a binary
format based on the widely used glTF (Graphics Library Transmission Format).

Product listing

If you select the layout type Category Page when creating a layout, your layout will automatically contain a
Product Listing Block. Here, the products of the respective category are displayed as standard.

In the settings of this block you can choose between standard, large images and minimal content in the
Content tab. You can find out about the differences between these displays here.

Sorting and Filter

Sorting

In the tab Sorting you can set how the products from the product listing should be sorted.

https://docs.shopware.com/en/shopware-6-en/catalogues/categories


Show product sorting (1): Here, you can activate or deactivate the selection of sort
orders for this product listing.

Use custom sorting (2): If you do not use your own sorting, the default sorting that
you have selected in the Settings > Shop > Products section will be used.  

Default sorting (3): If custom sorting (2) has been activated, you can select the
sorting according to which the product listing should be sorted by default. You can create
and edit the sorting under Settings > Shop > Products.

Product sortings (4): Here, you can select all the assortments that the customer
should be able to choose from in the product listing. The assortments are then displayed
in the frontend as a drop-down menu.

Priority (5): In the list of selected sorting options, double-click on the priority to change
it. In the frontend, the available sorting options are displayed in the order of priority,
starting with the highest.

Delete (6): Use the drop-down menu on the right to remove the selected sorting option
from the list.

Filter

In the Filter tab (1), you can define which filters are to be displayed in the storefront. The setting is also
possible at the category level and is explained in more detail in the documentation on the categories.

https://docs.shopware.com/en/shopware-6-en/catalogues/categories#product-listing


On the one hand, there is the area with the general filters (2) such as manufacturer, price, etc..
On the other hand, it is also possible to configure filters based on the product properties.
By default, all filters are active. To change this, activate the switch Configure filterable product
properties (3).

Here, you can define if the individual property (4) should be displayed as a filter in the category. Please
note that a filter is only displayed in the storefront if at least one product with this property is available in
the category.

Block Settings



To open the block settings click on a block in the preview and then clicking on the block settings icon
located just below the plus icon for new blocks. 
The basic settings for the currently selected block are entered here.

Name (1): This name is used to better distinguish this block. It is displayed in the
navigator, for example. 

Background colour (2): Here, you choose the background colour of the block. To
achieve uniform colouring, you can also specify the colour using the hexadecimal value.

Background image (3): Instead of a background colour, you can use your own
background image here. This can be a pattern or a background image for a text. 

Image mode (4): If you have created a background image, you can choose here
whether it should fill the block or whether the image should be aligned to the block.

Layout - CSS classes (5): In the layout settings, you can define the distance between
the elements of a block and its edges, and you can also include your own CSS class.

Section settings



To open the section settings, click on the icon for the respective section in the preview on the left and then
click on the section settings icon, which is located directly under the plus icon for new blocks.
Here you can enter basic settings for the currently selected section.

Section name (1): This name is used to better distinguish this section. It is displayed in
the navigator, for example.

CSS classes (2): You can add one or more CSS classes, separated by spaces.
Sizing mode (3): Here, you decide whether the content should be drawn to full width or
remain centred.

Mobile sidebar behaviour (4): If you activate the option Hidden, the content of the
sidebar will be hidden in the mobile view.

Background colour (5): Here, you can choose the background colour for the section.
You can also specify the color using the hexadecimal value to achieve a uniform color
scheme.

Background image (6) and image mode (7): Instead of a background colour, you
can use your own background image here. This can be a pattern or a background image
for a text.

Visibility by viewport



Visibility (1) allows you to customize the layout of an experience world for specific devices. Under Devices
(2), you can click to specify whether the layout should be shown or hidden on the corresponding viewport
or end device.
You can define this setting for individual block elements as well as for entire sections. The visibility per
viewport is also shown to you in the category configuration when the layout is assigned to a category.

Navigator

The navigator shows you an overview of all blocks by their name. You can change the order of the blocks
by drag & drop.
With the plus symbol you can create a copy of the block below the respective block. With the trash can
symbol you can remove the block.

Error Handling

https://docs.shopware.com/en/shopware-6-en/catalogues/categories#visibility


If you are unable to save your shopping experience, you will be informed directly in the designer that an
error has occurred (1). In the designer you will receive a precise error message about which element of
your shopping experience is wrong (2) and at which point the error occurs (3). In this way, you can quickly
correct wrong settings without having to search for the error.

Assign shopping experience to a page in the storefront

There are various ways of using an adventure world in the storefront.

Layout-Editor

You can assign the categories directly in the layout editor. To do this, click on Layout assignment (1) in
the menu on the right-hand side. Click on the button Assign layout (2) to open the window for the
assignment.

In the window for the assignment, click on the Select categories area, the list with the category selection
then opens. To apply the selection, click on the Assign layout button.



If a different layout has already been assigned to one or more selected categories, another window appears
in which you confirm the change again.

Shop pages



Experience worlds are used to display shop pages such as terms and conditions, imprint etc. The
assignment is carried out under Settings > Shop > Basic information in the shop pages area.

Categories

You can use experience worlds in the categories to customise the layout of the category listing. On the
other hand it is also possible to assign a landing page.

Landingpage

A Landingpage type shopping experience does not contain a fixed listing element to include products.
If it is not possible to call up the landing page from the normal navigation menu, activate the Hide in
navigation button in the Menu settings area.
The landing page can then be called up via the URL of the category to which the experience world is
assigned.



Product page

You can use an experience world for the product detail page. To do this, open the respective product in
Admin and open the Layout tab. Then select a created product page here.

If you have used changeable elements such as text boxes in your layout, you can change each element
individually for the respective product in the Layout tab.

Default layouts

Categories

When you create a listing page you have the possibility to assign this layout as default layout for all new
category pages. This will save you a lot of work
Just click in the sidebar in the Layout assignment > Default layouts > Set as default layout.

Product



When you create a product page you have the possibility to assign this layout as default layout for all new
product pages. This will save you a lot of work.
Just click in the sidebar in the Layout assignment > Default layouts > Set as default layout.

Media

This article explains the menu item Media, which you can find under Content > Media. Here you can upload
new media files, sort them into folders and manage existing media files. 
This files, you can use in other places in your shop (storefront, products, ...).

Overview

At the top you will find the search function, with which you can search media files.
Below you will find the Upload file button (1), which you can use to upload media from your local
computer. You can use the arrow to the right of the button to upload publicly accessible media via a URL.
On the left side you see the overview of all media files listed with name and preview picture. In the upper
right corner of this overview you can choose the way of presentation with the Presentation button (2)
and the way of sorting with the Sort by button (3). With Generate image (4) images can be generated
from a text promt using our AI-Copilot.  Via the button Add new folder (5) you can create a new folder at
the exact place in the folder structure, where you are and name it. When you select a medium or a folder in
the overview, you will find all information and actions (7) for this object on the right side.



You can also access the actions via the context menu (6) in the upper right corner of the medium.

File upload in the Media Manager supports the following file types:
jpg, jpeg, png, webp, gif, svg, bmp, tiff, tif, eps, webm, mkv, flv, ogv, ogg, mov, mp4, avi, wmv, pdf, aac,
mp3, wav, flac, oga, wma, txt, doc, glb

File already exists

As mentioned above, you can upload files using button (1). For example, if you want to upload an image
that has already been uploaded before, a pop-up will appear.

Here you have different options how to proceed.
Upload and replace: This will replace the previous file with the new one.
Upload and rename: The new file will be uploaded, but under a different name.
Use existing file: The already existing file will be used.
Skip file: This option only appears when you upload more than two files.

Media configuration

Actions

Replace - With this function you can replace an already uploaded medium with another one, which you
upload in the next step.



Download - Starts the download of the selected media files. 

Move - Here you can move the selected media files to another folder.

Copy link - copies the URL from the selected media file.

Delete - Deletes the selected media file. 

Preview

Here you can see a preview of the selected media. 

Meta data

Here you can find the metadata of the selected media file and here you can change the name, the alt-text
and the meta-title of the media file. 



 

Tags

Here you can set up tags so you can find them better. 

Used in

In this area you can see where in your shop you are using the selected medium. The places where the
medium is used are directly linked and can be accessed by clicking directly. 

Delete unused media

Unused media can take up a lot of storage space and make the media overview confusing, so it can be
useful to delete them. It is particularly useful to delete a large number of unused media via the console.  

Unused media can be deleted via the console using the command media:delete-unused.

You can find more information and further CLI commands here in our documentation.

https://docs.shopware.com/en/shopware-6-en/tutorials-and-faq/shopware-cli#media


Folder

The media can be sorted in folders for better overview and processing. You can create as many folders and
subfolders as you want and move the media to these folders.

Add new folder

By clicking on the button Add new folder, you can add a new folder at the exact place in the folder
structure, where you are and name it. A new folder with a folder symbol will be displayed in the overview
next to the existing media and folders. You can then open the folder with this icon.

In the folder you can jump back to a higher folder level by clicking on the Back icon.

Actions



As with the media files, the actions of the selected folder are displayed on the right side.

Move - Here you can move the folder to another existing folder.
Settings - Here you can open the folder settings. 
Dissolve - Here you can dissolve the folder. The folder will be removed and all folders and media that were
in the folder will be moved to the folder above it. 
Delete - This deletes the entire folder including all its contents.

Settings

The settings of the folder are divided into the general settings and the thumbnail settings.

Settings

In the general settings you can change the name of the folder on the one hand and on the other hand you
can specify for which media files this folder should serve as default location. For example, this could be all
product media files.

Thumbnails



In the thumbnail settings you can define all settings for the thumbnails that are used in the frontend, for
example. If you activate the option Inherit settings from parent folder (1), the same thumbnail
settings will be used for the current folder as in the parent folder. With the checkbox Generate
thumbnails for this folder (2) you can completely activate or deactivate thumbnail generation for this
folder. With Keep aspect ratio (3) you keep the aspect ratio of the original image. This ensures that a
rectangular image is not distorted with square thumbnail settings. In the field Thumbnail quality (4) you
can determine the quality of the thumbnails. 100 here means a very high quality, 1 a very low quality.
Under Thumbnail Size (5) you can define for which sizes thumbnails should be created. Via the link Edit
list in the upper right corner you can remove existing thumbnail sizes by clicking the red X. You can also
add new thumbnail sizes (6). If the lock symbol is activated, the width is automatically equal to the
height.

If you change the size of the thumbnails, you can regenerate them via the console. You do this with the
command “media:generate-thumbnails”, which you execute in the main directory of your Shopware
installation.

All console commands for the thumbnails can be found here.

The three default thumbnail sizes for all uploaded images are 400x400, 800x800, and 1920x1920.

AI-Copilot Text to image

With AI-Copilot image generation, you can easily create mood images by entering suggestions in natural
language. 

Once the media has been saved, you can use it in shopping experiences to make them more creative and
easier to design.  

The ‘AI Copilot - Text to Image’ feature is available from the Shopware Rise plan via the Shopware
Commercial extension.

To generate an image, you need to enter a description (1) for the desired image. Once you have found a
suitable description, you can have the image generated (2).  

https://docs.shopware.com/en/shopware-6-en/tutorials-and-faq/shopware-cli#media
https://docs.shopware.com/en/shopware-6-en/extensions/shopware-commercial
https://docs.shopware.com/en/shopware-6-en/extensions/shopware-commercial


The generated image is displayed with the description. Now you can decide to save it (1) or generate
another image with the description. The saved images are stored in the newly created AI-generated folder.

The image is completely regenerated during generation. This means that no adjustments can be made to
the image that has already been created. One image is generated per description. 
The number of requests is also limited per day. If you exceed this limit, you can only generate images
again the next day. 

We are using OpenAI’s DALL-E 3 for this Feature.

Model Viewer

The Model Viewer allows you to view 3D models directly within the administration panel – without the need
for any external tools. It is integrated into the Media module and appears automatically in the sidebar
preview as soon as a 3D file is selected. This allows 3D content to be checked quickly and managed
efficiently. When opened, the model is displayed in a neutral, empty scene, so that the focus is entirely on
the object.



Navigation follows standard 3D interactions: holding down the left mouse button rotates the model to view
it from all angles. The right mouse button moves the camera within the scene, whilst the scroll wheel lets
you zoom in and out to examine details more closely.

To view a larger image, you can maximise the Model Viewer using the ‘Expand’ button. When you do this,
the Model Editor opens as a modal window, offering additional functions in an enlarged view.

Model Editor

The Model Editor extends the Model Viewer with functions for editing 3D models. Whilst the Model Viewer is
used purely for viewing, the Model Editor allows you to actively modify the model and position it within the
scene.

Once a 3D model is opened in the Editor, it can be modified as required. The model's size can be adjusted
to scale it appropriately. Additionally, the object can be rotated to set the desired orientation.

By moving it within the scene, the model can be positioned precisely.

Editing is carried out directly and visually, so changes are visible immediately. Changes to the model are
saved directly, and the 3D file in the database is updated accordingly. This means that adjustments are
retained even outside the platform: if the edited model is downloaded and opened in another software
programme, the changes made will still be present. This allows the model to be optimally prepared and
adapted to the specific requirements.



Move tool (1): Activates the Move tool, which you can use to move objects in 3D
space. To change the position of an object, use the arrows:

Blue arrow = movement along the Z axis (forward/backward)

Green arrow = movement along the Y-axis (up/down)

Red arrow = movement along the X-axis (left/right)

Use the coloured squares to move the object along combined planes.
The middle square allows you to move it freely in all directions.

Rotate tool (2): Activates the Rotate tool, which allows you to rotate objects around
the three spatial axes.
To change the orientation of an object, use the rings:

Red = tilt forwards/backwards

Blue = tilt left/right

Green = rotate (around its own axis)

Yellow outer ring = rotation from the camera perspective

Scale tool (3): This allows you to enlarge or reduce the size of an object.
By default, objects are scaled evenly to maintain their proportions. If you deactivate
this option, you can stretch or compress an object along a single axis:

Green square = height

Red square = width

Blue square = depth

Themes



This section lists all themes that you have currently added to your Shopware installation. You can also
manage and edit them here.

All themes are listed in the overview. You can use the pull down menu(1) to change the sorting and switch
the view between listing and thumbnails.
Each theme has a context menu (2) where you can change and delete the thumbnail. This context menu
appears if you mouse over a theme and then click on the button with the three dots. It's possible for you, to
rename the theme or delete it completely. If a grey dot (3) is displayed below the preview image, this
theme is not yet assigned to a sales channel. If the theme is assigned to a sales channel, this point turns
green.

Theme configuration

In the theme configuration you can individually design your theme. Here you can select colors and fonts.

Theme-colours

Here you can define the basic background and frame colors for your theme. The primary color can be found
in the Responsive Theme, for example, in the headings and links.

Example: 

https://docs.shopware.com/en/shopware-6-en/saleschannel


Status messages

Here you can adjust the colors of the status messages in your shop.

Examples: 

Typography



Here you can adjust the font and text color of texts and headings of the theme.

Example:
An example for the fonts of the texts and headings is an element in the article listing.

E-Commerce

Here you change the appearance of the buy button and the displayed price.

Example: 



Media

In this area you define the logos and icons. A viewport larger than 991px will display the desktop logo.
Between 991px and 767px the tablet logo is displayed. A viewport smaller than 767px, will display the
mobile logo.
The favicon is displayed in front of the URL in the browser and the app & share icon is displayed as a
preview, for example, if the page is shared in social networks.

Create duplicate



Only themes, not already inherited from other themes, can be duplicated. In that case, the option is not
present in the context menu.

To create a duplicate, select Create Duplicate in the context menu of your desired theme.
After you have given your duplicate a name, the configuration of your theme will open.
You will notice that the configuration of your theme is inherited from the duplicated theme.
This inheritance can be switched off for individual configurations by clicking on the inheritance logo, so that
you can make individual changes to your duplicated theme.
You can find more information about other possible changes to the template here.

Assign theme to a sales channel

To use a theme for a storefront it is necessary to assign the theme to the corresponding sales channel. To
do this, open the Themes tab in the respective sales channel. There you can assign a theme to the sales
channel.

First, you will see the theme that is currently assigned to the sales channel. By clicking on the theme
thumbnail or Change Theme, you can assign one of the installed themes.

https://docs.shopware.com/en/shopware-6-en/tutorials-and-faq/changing-a-template


Marketing

In this section you will learn everything about the existing options, which are shown to you in the point
Marketing of your administration.

Newsletter recipients

You can find the newsletter recipients in the admin under Marketing > Newsletter Recipients.

Overview

In the overview you will find a list (1) of all customers who have registered for the newsletter in their
account. Next to each entry you will find a context menu (2) where you can remove or edit the entry. 
Via the list settings (3) you can determine which information should be displayed to you here. With the
filter (4) you can limit the number of displayed entries according to the desired parameters.

Status

Awaiting activation: The double opt-in function is activated and the customer still has to confirm his
registration.

Immediately Active: This status is displayed when the double opt-in function is disabled and the
customer has signed up for the newsletter.

Active: The customer has confirmed his registration.

Awaiting deletion: The customer has unsubscribed from the newsletter and deletion from the
newsletter recipient is required.

Filter



The filter can be used to narrow down the overview by status, language or sales channel.

Edit recipient

Via the context menu in the overview you have the possibility to edit every newsletter recipient, his
address, language and e-mail address. The Tags entry allows you to store your own keywords, which you
can use to find this entry more easily in the overview and search function.



Promotions

The menu item promotions offers you a module with which you can create discount actions for your sales
channels. Within this module you can create rules to set up restrictions for the promotions, as well as limit
the promotion to a certain time frame.

Overview

The discount module shows you an overview of all your currently running or configured promotions.
Within this mask you can a create new promotions or view existing promotions.
By clicking on the symbol to the right of an existing promotion, the context menu opens, which offers you
the options to edit or remove the existing promotion.

Create a new discount promotion

To create a new discount action you have to click on the button Create action within the mask.
This opens a new mask where you can now set the basic configuration for a new discount promotion.

The advanced configuration regarding rules and discount definition can be defined in the tabs Conditions
and Discounts. These are available as soon as the action has been saved for the first time.



General

General settings
Here you will find all the general details of your discount promotion. This is where you can edit and adapt
them according to your wishes.

Name (1): Here you can give your action a name / designation.

Priority (2): Define the priority to determine the order in which rules are applied if more
than one rule applies.
(A rule with priority 2 is applied before a rule with priority 1, but after a rule with priority
3)

Valid from / Valid until (3): You can use these fields to define whether your action
should run for a limited time and, if so, from when to when.



Max. total uses (4): Specify how often the discount promotion can be used in total.

Max. uses per customer (5): Specify how often the discount promotion can be used
per customer.

Active (6): This switch can be used to activate and deactivate the promotion. If the
promotion is deactivated, it will not be played in the valid period.

Promotion codes

Promotion codes: If you do not want the promotion to be applied directly when one of your customers
fulfils the corresponding conditions (e.g. add certain products to the shopping cart or reach a certain value
of goods), you can also store a promotion code. The promotion will only be applied when the code is
redeemed and the conditions are met.

No promotional code required:
No separate entry is required for the promotion to be applied.

Fixed promotion code: 
This selection allows you to enter a single code that is the same for all customers. For example, this
could be a memorable code such as EASTER21 Alternatively, you can use the generate random
code button to have the system assign a random code.

Individual promotion codes:
Here you can use individual codes for each order.



These individual codes can only be redeemed once and will not be accepted if they are entered again. The
list of codes tells you straight away whether a code has already been redeemed and, if so, by which
customer.To initially create the first action codes, click on the button generate codes (2). A window will
open in which you can configure the codes.
If you have already created action codes, you can use the button add codes (1) to generate further codes
according to the already defined pattern. This can be useful, for example, if a large part of the generated
codes has already been used before the planned end of the action is reached.

Note: It is not possible to apply several different individual codes from a single promotion at the same time.

In the field code length (1) you determine the number of random characters the code should consist of. In
addition, you can optionally enter a prefix (2) and suffix (3), which will be prefixed or appended to the



code. The characters used here are not counted towards the character length of the random code. In our
example in the screenshot above, the prefix is SW- and the suffix is -TEST.

Alternatively, you can use the use custom pattern (4) button to define the pattern according to which
the codes are to be structured. This can be both fixed letters and numbers as well as random characters
stored by the system. To insert a random letter (A-Z), store %s, for a random number (0-9) %d. In our
example, the custom pattern looks like this: SW-%s%d%s%d%s-TEST.

The promotion code preview (5) shows you an example of how the codes will look. Finally, in the field
number of promotion codes (6) you determine how many codes are to be generated according to the
set pattern.

Please note that the subsequent adjustment and regeneration of the promotional codes will result in the
previous codes becoming invalid and therefore no longer redeemable.

Conditions

The Conditions tab offers you the possibility to specify exactly when the promotion is valid and when it is
not. This is done by applying specific rules from your rule builder to limit your discount promotion based on
given conditions.

Conditions

You can specify here the conditions under which the promotions are to be displayed.

Sales channels: Specify here for which sales channels the promotion counts. 
Prevent combination with other promotions: Activate the slider, if no other promotion can be used in
the shopping cart, even if their conditions theoretically apply.
Do not combine with: At this point you can add already existing promotions that should not be
combinable with this new discount promotion.

Rule based conditions

https://docs.shopware.com/en/shopware-6-en/settings/rules


Conditions can be defined here using the Rule Builder for your target group, the shopping cart or also
the entire order, for which exact conditions the promotion is to be applied.

Customer rules (1): Using the customer rules allows you to apply Rule Builder rules to determine which
of your shop's customers are entitled to benefit from the action you have created. You can also specify
multiple rules here. 
The drop-down menu customer rules lists all existing Rule Builder rules that refer to customers and gives
you the option of creating new rules for them.
Shopping cart rules (2): You can use these rules to set conditions that need to be met for the contents of
the shopping cart. These can be conditions such as "Goods with a total value of 100 euros or more are in
the shopping cart" or "There are at least 3 products in the shopping cart".

If multiple rules have been selected, only one of them needs to be triggered to apply the promotion. This
improves user-friendliness if a promotion is to be applied to several different conditions. If you intend for all
included rules to trigger a promotion together, it is necessary to set up the promotion multiple times.

Order rules (4): Here it is possible to define general conditions that must be met by an order so that the
discount promotion can be redeemed. A condition could be, for example, the use or exclusion of certain
payment or shipping methods.
Promote sets of products (3): A set of products is a powerful tool for creating complex, product-related
conditions that relates to several products at once or that require a given combination of products to be in
the shopping cart in order to meet the discount conditions. Concrete examples that can be implemented
with the help of product sets or set groups can be found below in the section Examples. 
If you activate this option, you can add a set group using the add product set button.



A set group is defined by four properties.
Mode (1): Indicates whether the entry in the Value (2) field refers to quantities in the shopping cart
(Number), to the gross price that must be reached by this set group (Value (Gross)) or to the net price
(Value (Net)).
Value (2): Entries made here indicate the number or value of products that must be reached to meet the
conditions for this set group.
Sorting (3): Specifies whether products are assigned to the set group in ascending or descending order -
depending on their purchase price.
Product rules (4): At this point, further Rule Builder rules can be applied that must be met in order for
products to become part of this set group.

To better illustrate how set groups can be used, let's take the following example from the screenshot:

In this example, we use "T-Shirt" as the product rule (which ultimately contains a selection of T-shirts -
previously defined in the Rule Builder). As soon as there are three T-shirts (because 3 is defined as a value
and number as a mode) in the shopping cart, a set group of these T-shirts is formed. It does not matter
whether it is the same T-shirt three times or three different T-shirts.
If there are four matching T-shirts in the shopping cart, the three cheapest T-shirts (sorted by "price
ascending") are combined into a set group. The fourth, most expensive T-shirt remains "separated".
If there are six matching T-shirts in the shopping cart, two groups of this set are formed. First the three
cheapest and then the three most expensive. For further T-shirts, the same principle would be applied.

Advanced Selection

For each rule, you can use the advanced selection (1) to define complex conditions with the Rule Builder
- for example, based on customer groups, product categories or shopping basket values.

https://docs.shopware.com/en/shopware-6-en/settings/rules


 
Clicking on the advanced selection opens a new window in which all available rules from the Rule Builder
are displayed.

You can select the desired rule in the selection field (2) and then confirm by clicking on the Apply
selection (3) button.

Discounts



With the sub item discounts you can define when a discount is offered and what is discounted. 
A distinction is made between percentages, i.e. pro rata discounts, and absolute discounts.
You can store these here with a value and determine what they are to be applied to.

It is possible to run multiple discounts at the same time through a discount promotion. To add another
discount, simply press the Add Discount button.

Please note that you cannot change the discount settings after the promotion has been used for the first
time in an order.

Apply to (1): Here you can choose on which products the discount should be applied. On the entire
shopping cart, on the shipping costs, on the entire product set (i.e. on all existing set groups) or on one of
the existing set groups defined in the conditions in the shopping cart section.
Apply to specific range of products only (2): Here you can specify that the discount is only applied to
certain products. If you activate this option, the fields Product rules, Apply to and Sort by are also available.

Product rules: In this way, it is possible to break down the discount promotion even further to specific
products. To explain the difference to the product rules in the conditions, the following example: If
the rule is set in the shopping cart conditions that black T-shirts must be in the shopping cart, then
the condition is met as soon as there is a black T-shirt in the shopping cart. However, this does not
mean that the discount only applies to this black T-shirt, but could theoretically be applied to the
entire shopping cart.
If you were to apply the discount to selected products in the discount settings and apply the product
rule for black T-shirts again, then the discount would really only be granted for black T-shirts, even if
there are other items in the shopping cart that are still charged normally.

Apply to: In the event that there are several products for which a discount is granted, it can be stored
here that, for example, a discount is only granted for every second/third/xth product. The order is
determined by the setting Sort by (price ascending or descending).

Sort by: If there are several products on which a discount can be granted, the products to be
discounted are sorted by price in ascending or descending order. This setting becomes more
important in combination with the settings apply to and maximum application.



Type (3): Here you specify whether the discount should be an absolute discount, a percentage discount or
a fixed price or fixed unit price. If you decide on a fixed price or fixed unit price, the price cannot be higher
than the undiscounted/normal total or unit price.
Value (4): This field indicates the actual value of the discount. For example, if you enter 20 here, then
depending on the selected type, a basic discount of 20 euros would be granted or a discount of 20% or a
fixed (unit) price of 20 euros.
Maximum discount value (5): If a percentage discount is specified as the type, the Maximum discount
field is displayed. This allows you to set an upper limit for the discount so that the discounted percentage
cannot exceed the amount specified here.
Open advanced prices view (6): Here you can set the value of the discount for each currency
individually.

Common examples of discounts

Below we list the most common discount campaigns with a corresponding example. You can find more
examples in our tutorial.

Time limited "20% off everything except..."

The aim of this promotion is to provide a limited time discount promotion on all items except a specific
range of products.

General:
In the general sub-tab, we first assign the name of this discount promotion and set it to active. In the fields
valid from and valid until we enter the period of the promotion. Then we save this promotion for the first
time.

Conditions: 
Since this promotion should apply to "all" products, we only need to specify in the Conditions sub-tab which
sales channel the discount promotion should apply to. The exception rule for items that should not benefit
from this promotion are set later in the discounts tab.

Discounts
In the Discounts tab, we apply the discount to the entire shopping cart. The apply to selected products only
button is set to active.
In the drop-down field product rules that is now available, we click on the item create new rule.
A new modal opens, which is essentially similar to the view of the Rule Builder.

Here we assign an appropriate name for the rule, set the priority and optionally a description.
As a condition, we select the option line Item as an example. The operator is is none of and then we add all
products here that we want to exclude from the discount promotion. Then we save the new rule. More
detailed information on how to use the Rule Builder can be found in the corresponding documentation.

https://docs.shopware.com/en/shopware-6-en/tutorials-and-faq/promotions-example
https://docs.shopware.com/en/shopware-6-en/settings/rules


Now we click on the drop-down field Product Rules and this time select the rule we have just created. In
this way we have ensured that the discount promotion is applied to all products in the shopping cart except
for the products just defined in the rule.
In the Type field we select the Percentage option. In the Value field we enter the percentage. If necessary,
we can set an upper limit for the discounted amount with the field maximum discount value. Finally, we
click on Save again to complete the configuration of the discount action.

At this point the question might arise why we have included the exception in the product rules for discounts
and not as a condition for shopping cart and/or set groups.
If we had specified the same product rule as a condition for the shopping cart, this would mean that the
discount promotion can no longer be triggered as soon as there is even one product in the shopping cart
that has been defined as an exception.
If there were also products in the shopping cart that should actually be discounted, these would also no
longer be discounted. The exception products would first have to be removed from the shopping cart so
that the condition is "true" again and the discount promotion is therefore valid.

Promotions with a minimum order value

In this example, we create a discount promotion that can only be triggered when a certain minimum order
value has been reached. In our example, this would be from an amount of 100 euros or more.
General: 
So when we create the promotion, we enter the to use relevant fields like name and promotion period in
the general tab again and set them active and save to unlock the conditions and discounts tabs again.
Conditions:
To create a promotion that should only be valid from a certain minimum order value, it is sufficient to
define a shopping cart rule in the conditions tab in the rule based conditions section.
In the shopping cart rules drop-down menu, we select the option create new rule to open the rule builder
modal.
Here we assign a name for the rule and set the priority.

Depending on your own preferences, two condition types can now be considered for this promotion - the
total or subtotal of all items types. 
The total type takes into account the actual total amount including all non-product-related items except
shipping costs. Subtotal of all items only takes into account the actual value of all products in the shopping
basket. Other items such as shipping costs or discounts (e.g. other discount campaigns, vouchers) or
surcharges (e.g. cash on delivery charges) of any kind are not taken into account. 
Once you have selected the right type for you, select the correct operator. In our example, this is the
greater than/equal to operator.
We enter 100 as the value here as an example. We then save the settings to create and apply the rule.

Discounts:
Finally, define the discount that suits you in the discounts tab and save the promotion to apply the
changes.



3 for 2

The creation of a "3 for 2" action is done with a set group. How this is configured in detail is explained in
the following example.
General:
With the exception of the name, the settings in the general section are optional. Therefore, we will not
elaborate further. Information on this can be found in this documentation above in the section creating a
new discount promotion > general.
Conditions:
First of all, the setting in the area conditions > rule based conditions are relevant for the actual
configuration.

Activate the button promote sets of product sets (1) to activate the extended configuration.
Here you can now specify how the set is to be composed. In our example, from the quantity (2) of
products, store 3 as the value (3).
The sorting (4) determines how the individual sets, to which the discount is then applied, are formed. To
ensure that the cheapest product in the shopping basket is always discounted, select price, ascending
here.
Use the product rules (5) to determine which products are to be included in the promotion. In our
example, there should be no restrictions.
Discounts:
The following settings are required in the Discount section:

https://docs.shopware.com/en/shopware-6-en/marketing/promotions#general
https://docs.shopware.com/en/shopware-6-en/marketing/promotions#general
https://docs.shopware.com/en/shopware-6-en/marketing/promotions#discounts


The discount is to be apply to set group-1 (1).
For further configuration, activate the check box apply to specific range of products only (2).
The discount is to be apply to 1.item (3) and the sorting is in ascending order (4). Optionally, you can
specify whether the discount should only be applied to a limited number of products in the shopping
basket. If you select 1x, for example, your customer will only receive 1 product free, even if they buy a
total of 6 products. Without this limitation, your customer will receive the two cheapest products for free in
this case (one free product for every 3 products).
As item picking mode (5) we use horizontal. In this way, the cheapest products are added for free in
multiples of 3 products. The following table illustrates how the discounting behaves in the two modes:

Product Price Free with Vertikal Free with Horizontal

1 10 X X

2 20   X

3 30    

4 40 X  

5 50    

6 60    

The discount is of the type (6) percentage with the value (7) 100.
Optionally, you can set a maximum discount value.
After you have saved and activated the action, your customers can benefit from the discount.



Apply discounts in the Storefront

Depending on the discount configuration, it may first be necessary to activate the discount by entering a
code.
This is possible in the OffCanvas shopping basket and in the normal shopping basket view by entering the
code in the field Enter voucher code (1), then confirming the entry by clicking on the tick button (2).

OffCanvas shopping cart

Shopping cart

After successful entry the discount (1) is listed in the article overview.

OffCanvas shopping cart



Shopping cart

You can find more examples of discounts and promotions in our tutorial.

Display of voucher codes already redeemed

Action codes that have already been used can be displayed in different ways. This can be interesting, for
example, if you want to know on which order a general or individual code has already been used.

Individual promotions codes

To see who has already used the individual code of your promotion, you only have to open the actual
promotion below Marketing > Promotions.

https://docs.shopware.com/en/shopware-6-en/tutorials-and-faq/promotions-example


Underneath Redeemed you can now see which of your codes has already been successfully used in an
order.

Now you probably want to take a look at the corresponding order. To do this, simply note or copy the
voucher code and go to the order overview.

Using the filter function in the right-hand area, you can now filter for orders with this code via the item
promotion code and have only this order displayed.

Fixed promotion code

If you have a fixed promotion code, you can copy this code and go directly to the order overview. Again,
you can use the filter function to search for orders with this code.

In contrast to the individual promotion code, you will now find more than one order here, depending on the
configuration of your promotion.
 



Extensions

In this section you will find all articles related to the extensions section in Shopware Admin.

My extensions

Please note that this article is only for users of a self-hosted shop. It is not relevant for users of a Shopware
6 SaaS environment.

Shopware 6 offers you the option of extending the range of functions. To do this, go to Extensions > My
Extensions and manage the extensions that are already available for your shop. You can purchase new
extensions in the store.

The area of my extensions is divided into several subsections.

Apps (1): Shows you an overview of the apps available in the shop and in your account.
Theme (2): Shows you an overview of the themes available in the shop and in your account.
Recommendations (3): Here you will receive recommendations for extensions, divided into regions and
categories.
Shopware Account (4): Here you can link your shop with your Shopware account.
Upload extension (5): If you have an extension as a zip file, you can upload it here.



Detailed information on the respective section can be found further down in this documentation.

Apps

The apps section offers you an overview of all apps added to your shop.

The app overview is divided into several columns

Overview of apps (1): Here you can see an overview of all apps and the most important information
about each app. 
Hide inactive extensions (2): Use this button to hide all apps that are currently not activated, in order to
obtain a better overview of the active apps. 
Sorting (3): Here you can specify the criterion according to which the overview should be sorted. 
Active button (4): With this button, you can activate or deactivate installed apps. In contrast to
uninstalling, deactivating has the advantage that settings you have made in the app are not lost. 
Install app (5): If you upload an app or have bought one in your Shopware account, it is not yet installed
in your shop. You can install the app using this button. Please note that the app is initially deactivated after
installation. If you want to use it straight away, it is necessary to activate it right away. 
"..." button (6): Here you can call up the context menu for the respective apps. Different functions are
then available in the menu, depending on the status of the app.
Uninstall: Uninstalls the app but does not remove it completely from the system so that it remains in the
overview. This option is available if the app is installed.
Remove: Removes the app from the system. This option is available if the app is not yet installed or has
been uninstalled.
Configuration: Opens the configuration menu. This option is available for apps that use their own
configuration menu (e.g. the PayPal app).
Upload extension (7): Here you can manually add an extension to the shop. You can download the zip



file required for this in the extension management of your Shopware account, for example.

Notes on the active status
The active slider has three states, which are differently displayed.

Active

A white button upon a light blue background indicates that the app is active.

Inactive

If a white button is displayed upon a gray background, the app is not active. 

Uninstalled

An uninstalled app is indicated by a dark gray button on a light gray background. In addition, Install app is
now displayed on the right-hand side.
The license for the extension is therefore still available, and the app can be reinstalled at any time.

Theme

The Themes section offers you an overview of all themes added to your shop.



The overview is divided into several columns

Overview of themes (1): Here you can see an overview of all themes and the most important information
about each theme.
Hide inactive extensions (2): Use this button to hide all themes that are currently not activated, in order
to obtain a better overview of the active themes.
Sorting (3): Here you can specify the criterion according to which the overview should be sorted. 
Active button (4): With this button, you can activate or deactivate installed themes. In contrast to
uninstalling, deactivating has the advantage that settings you have made in the theme are not lost.
Themes that are active here are not automatically assigned to a sales channel. The assignment only takes
place in the sales channel.
Open app (5): This link takes you directly to the configuration page of the theme."..."
button (6): Here you can call up the context menu for the respective theme. You can uninstall installed
themes here. You can completely remove already uninstalled themes from the administration here.

Recommendations

The Recommendations section provides you with extension recommendations for certain areas of your
shop.

First, you select the region and category for which you would like to receive recommendations. These are
then displayed below the categories. Click on the Install button to add the app directly to the app overview
and install it.

Shopware Account

Here, you can connect to your Shopware account to get access to your purchases.



In order for the login to work without problems, it is necessary that you have registered and verified your
domain, information on how to do this can be found here.

Installing extensions

If the desired extension is not yet listed under apps or themes, it is first required that you add it. This is
possible in two ways.

On the one hand, you can connect to your Shopware account under Account. After you have logged
in, all the extensions that have already been obtained for the shop's domain are available to you
under apps and themes. There you can install the desired extension.

Alternatively, you can upload the extensions manually. You can download the necessary zip file in
your Shopware account in the Merchant area. You can find more information about the Shopware
account here.

Now that the extension is available under apps or themes, you can install it. To do this, open the context
menu by clicking on the "..." button. Click on Install in the menu. You can then activate the extension using
the button in the Status column.

Configure extensions

Some active extensions have their own menu item under Settings > Extensions, which you can use to
open the configuration of the extension. Information on the function and configuration of the individual
extensions can be found in the respective extension documentation.

Update extensions

https://docs.shopware.com/en/shopware-6-en/settings/system/shopwareaccount
https://docs.shopware.com/en/account-en/merchant-area/shops#where-can-i-find-my-licences


If updates are available for extensions/apps, this will be displayed in the corresponding line of the
extension/app in the app overview, next to the current version of the extension/app.  The update will be
triggered by clicking on Update (1). It will be checked whether you are authorized to update and the
update will then be carried on or rejected with a corresponding message.

Uninstall extensions

Extensions can naturally also be removed. If you want to uninstall an extension, navigate to the menu
Extensions > My extensions, click the "..." button on the respective extension and choose Uninstall.
In the following menu, you often see a push button labelled "Remove all app data permanently", which
provides a way to remove all data regarding the extension, such as settings.

You can find out how to remove defective extensions here.

Warning: The option Die Option Remove all app data permanently is irreversible.

Image keyword assistant

The Image keyword assistant is an AI feature and part of the Shopware Commercial extension. The
assistant is available to all customers with a commercial plan.

Configuration

Use image keyword assistant activates the feature.

Below this, the language for the keywords can be configured.

If you want to add the keywords to the alt text, you can do this by selecting the next
checkbox Add keywords to image alt text.

https://docs.shopware.com/en/shopware-6-en/tutorials-and-faqs/disable-functions
https://docs.shopware.com/en/shopware-6-en/extensions/shopware-commercial
https://www.shopware.com/en/pricing/


In the last step Alt text data handling you can configure how the generated data
should be used. The following options are available.

Overwrite the existing keywords

Append the existing keywords

Prepend the existing keywords

Do not adjust existing keywords

 
 

Using the Image Keyword Assistant

Automatic Processing: The assistant automatically starts processing any media
uploaded after its activation.

Status Display: Once a process has started, the processing status is visible in the 
Content > Media section. It will indicate that the assistant is actively working on the
media.

Important Note on Existing Media:
A common misunderstanding is that the assistant also automatically processes media that was
already uploaded.
This is not the case. Existing media will only be reprocessed if the media file is re-uploaded using the
"Replace" function. Only then will the assistant re-trigger the tagging process.



Settings

The menu item Settings offers you an overview of the numerous configuration options for your sales
channels.
Here you see a preselection of the individual configuration groups including icons.



Sales channel

The sales channels represent the interface from your administration to the storefront. You can create your
own sales channel for each channel you want to use to sell your products. 
In addition to an online shop, it is also possible to connect a merchandise management system, which is
directly linked to your local shop. 

All information about the sales channels can be found here.

Social Shopping - Instagram, Pinterest &
Facebook

Installation

Social Shopping is an extension that is part of the Shopware Rise plan.

If at least the Shopware Rise plan is stored for the store domain in the Shopware account, you can
download and install it under Extensions > My Extensions.
The prerequisite is that you are logged in with your account in the Shopware Account tab. 
After the extension has been installed, you can activate it via the button on the left side.

General Information

The extension provides additional sales channels that allow easy integration into the well-known social
media services. In most cases this is done through an export feed, which is integrated into the respective
platform
 

https://docs.shopware.com/en/shopware-6-en/settings/saleschannel


If you want to disable Social Shopping, it is necessary to delete the sales channels created with Social
Shopping beforehand.

In the customer and order areas of the administration, the column "Referral" is added to the entries for
customers and orders. This tells you where the customers or orders come from if they were placed via a
social shopping sales channel. For this, however, the referral code must be included in the individual
templates. Information on this can be found in the various template areas.

Facebook

The "Facebook" sales channel provides the data required for export to Facebook in an XML feed.
 

Configuration

Language selection (1): Here you define for which language you want to setup the configuration. It is not
necessary to maintain the settings in each language, because these settings are always inherited from the
main language, if no own settings are made in a language. However, it may be useful to select the
respective storefront sales channel domain for each language, for example, to direct customers to the
appropriate language.

In the tab General (2) you can configure the export feed generated later. The tabs Statistics (3), 
Unpublished Products (4), Intergration (5) and Template (6) will only be displayed after the basic
configuration has been completed and the settings have been saved.
 



General

Name (7): Enter a name for the sales channel here. This is used, for example, in the
sales channel overview in the menu on the left side.

Active (8): Activate the generation of the feed. If the feed is not active, no further
generation takes place and it cannot be accessed through the URL.

Storefront sales channel (9): Select here which storefront should be used for the
integration. This storefront will be used to display or purchase the articles through
Facebook.

Storefront sales channel domain (10): Based on the selected storefront sales
channel you can choose the domain to be used. This is especially important if the
storefront is accessible through different domains or if different languages are used.

Currency (11): Here you define the currency in which the products should be displayed.
You can choose from the currencies that are available in the assigned storefront sales
channel.

Dynamic product group (12): By assigning a dynamic product group, you define
which products should be exported to the feed for Facebook. To learn how to create a
dynamic product group, please refer to the appropriate documentation.

Additional settings

https://docs.shopware.com/en/shopware-6-de/Catalogues/Dynamicproductgroups


Import variants as own products (1): With this setting you can determine whether
each variant of variant products is transferred to Facebook as an independent product.
Alternatively, a collective product is used, in which the general product information is
listed. However, information on the individual variants is not included.

Generation interval (2): Use this setting to define how often the feed should be
regenerated for export. If you select "Live", the feed is generated each time it is called
up. For production systems, we recommend that you do this using the scheduler. More
information about the scheduler you can find here.

Generate by Scheduler (3): This option allows you to have the feed generated via the
Message Queue System with a scheduled task. Please note that the feed will only be
generated when the generation interval has expired. To learn how to set up Scheduled
Tasks, see the Scheduled Tasks article.

Default Google Product Category ID (4): The Google Product Category ID
determines the category in which the products will be included on Facebook. Please note
that only purely numeric values can be used here. You can find more information on this
on the Google help page, which is also linked in the admin section at the appropriate
place. 

Time of last generation (5): Here you can see when the export feed was last
generated. This also allows you to see if the generation by the scheduler is executed
correctly.

Options

Please note that the item options only becomes available after the sales channel has been created (saved
initially).

Delete sales channel (1): Here you can delete the sales channel within Shopware. It
may be necessary to make additional adjustments to Facebook.

Statistics

https://docs.shopware.com/en/shopware-6-en/tutorials-and-faq/message-queue-and-scheduled-tasks#scheduled-tasks
https://docs.shopware.com/en/shopware-6-en/tutorials-and-faq/message-queue-and-scheduled-tasks
http://support.google.com/merchants/answer/6324436


With the statistics, you can view various key figures of your orders via Facebook. These are divided into
orders, customers and turnover. Each statistic can be limited to different time periods, such as the last 24
hours or the last 30 days, via an option in the upper right corner.

Without the respective variable for the referral code in the template, the statistics cannot be calculated.
You can find more information on this in the template section.

Unpublished products

Please note that the unpublished products tab is only available after you have set up and saved the
general configuration.

Validate products (1): You can validate products at this point.

Result of the validation (2): After the validation has been carried out, you can see
here whether the products are transferd complete. If the validation should determine
that products are not valid, the corresponding products are listed here. In this case you
should then check whether any data is missing or whether the existing data is invalid
(e.g. due to characters that cannot be displayed correctly).

https://docs.shopware.com/en/shopware-6-en/extensions/social-shopping#template


Integration

Shopware itself provides you with the data required for integration into Facebook in an export feed. The
integration with Facebook is done directly in your Facebook settings.

Please note that the Integration tab is only available after you have set up and saved the general
configuration.

Export-URL (1): The generated feed can be accessed under the export URL and can be queried from
Facebook.

You can find more information in the Facebook documentation.
General information about the shop on Facebook
https://de-de.facebook.com/business/help/238403573454149?id=206236483305742
Information on catalog management
https://www.facebook.com/business/help/125074381480892?id=725943027795860
and
https://www.facebook.com/business/learn/lessons/manage-inventory-with-catalogs

Template

https://de-de.facebook.com/business/help/238403573454149?id=206236483305742
https://www.facebook.com/business/help/125074381480892?id=725943027795860
https://www.facebook.com/business/learn/lessons/manage-inventory-with-catalogs


The template determines the structure of the product export file. The template is divided into a header line,
a product line and a footer line.
If you use a template in the General tab, usually no adjustments are necessary here. The correct document
templates for the respective comparison portals are already included in the templates. 
The Test template (1) button checks whether there are any syntax errors in the template. With
Generate preview (2) you can directly view the content of the created export file.

More information about the templates you can find here.

Under Variables (3) you can see which data you can use for the template.

https://docs.shopware.com/en/shopware-6-en/Productcomparison#template


With a click on the arrow, you can see a dropdown with all available variables. There you can copy the
variable you want to the clipboard by clicking on the copy symbol again.

Referral-Code

In order for the statistics to be calculated, the Facebook sales channel template must contain the following
variable:

{{ socialShoppingSalesChannel.salesChannelId }}

This variable is automatically added to the standard template for new social shopping installations or
updates. However, if you have previously adapted the template yourself, you must manually add this
variable once and thereby extend the variable to the SEO URL, so that the following line is then created:

<g:link>{{ seoUrl('frontend.detail.page', {'productId': product.id}) }}?referralCode={{ socialShoppingSalesChannel.salesChannelId }}</g:link>

Instagram

The Instagram sales channel provides an XML feed that contains all information relevant to Instagram.

Configuration

Language selection (1): Here you select for which language you want to hear the configuration. It is not
necessary to maintain the settings in each language, because these settings are always inherited from the
main language, if no own settings are made in a language. However, it may be useful to select the
respective storefront sales channel domain for each language, for example, to direct customers to the
appropriate language.

In the tab General (2) you configure the export feed generated later. The tabs Statistics (3), 
Unpublished products (4), Integration (5) and Template (6) will only be displayed after the basic
configuration has been made and the settings have been saved.



General

Name (7): Enter a name for the sales channel here. This is used, for example, in the
sales channel overview in the menu on the left side.

Active (8): Activate the generation of the feed. If the feed is not active, no further
generation takes place and it cannot be accessed through the URL.

Storefront sales channel (9): Select here which storefront should be used for the
integration. This storefront will be used to display or purchase the articles
throughInstagram

Storefront sales channel domain (10): Based on the selected storefront sales
channel you can choose the domain to be used. This is especially important if the
storefront is accessible through different domains or if different languages are used.

Currency (11): Here you define the currency in which the products should be displayed.
You can choose from the currencies that are available in the assigned storefront sales
channel.

Dynamic product group (12): By assigning a dynamic product group, you define
which products should be exported to the feed for Instagram. To learn how to create a
dynamic product group, please refer to the appropriate documentation.

Additional settings

https://docs.shopware.com/en/shopware-6-de/Catalogues/Dynamicproductgroups


Import variants as own products (1): With this setting you can determine whether
each variant of variant products is transferred to Instagram as an independent product.
Alternatively, a collective product is used, in which the general product information is
listed. However, information on the individual variants is not included.

Generation interval (2): Use this setting to define how often the feed should be
regenerated for export. If you select "Live", the feed is generated each time it is called
up. For production systems, we recommend that you do this using the scheduler. More
information about the scheduler you can find here.

Generate by Scheduler (3): This option allows you to generate the feed by cronjob at
a certain time. Please note that the feed is only generated when the generation interval
has expired.

Default Google Product Category ID (4): The Google Product Category ID
determines the category in which the products will be included on Instagram. Please
note that only purely numeric values can be used here. You can find more information on
this on the Google help page, which is also linked in the admin section at the appropriate
place. 

Time of last generation (5): Here you can see when the export feed was last
generated. This also allows you to see if the generation by the scheduler is executed
correctly.

Options

Please note that the item options only becomes available after the sales channel has been created (saved
initially).

Delete sales channel (1): Here you can delete the sales channel within Shopware. It
may be necessary to make additional adjustments to Facebook.

Statistics

https://docs.shopware.com/en/shopware-6-en/tutorials-and-faq/message-queue-and-scheduled-tasks#scheduled-tasks
http://support.google.com/merchants/answer/6324436


With the statistics, you can view various key figures of your orders via Instagram. These are divided into
orders, customers and turnover. Each statistic can be limited to different time periods, such as the last 24
hours or the last 30 days, via an option in the upper right corner.

Without the respective variable for the referral code in the template, the statistics cannot be calculated.
You can find more information on this in the template section.

Unpublished products

Please note that the unpublished products tab is only available after you have set up and saved the
general configuration.

Validate products (1): You can validate products at this point.

Result of the validation (2): After the validation has been carried out, you can see
here whether the products are transferd complete. If the validation should determine
that products are not valid, the corresponding products are listed here. In this case you
should then check whether any data is missing or whether the existing data is invalid
(e.g. due to characters that cannot be displayed correctly).

https://docs.shopware.com/en/shopware-6-en/extensions/social-shopping#template-1


  

Integration 

In order to integrate the products exported through the feed with Instagram, it is necessary, among other
things, to link the Instagram profile to your own Facebook account.
 

Please note that the integration tab is only available after you have set up and saved the general
configuration.

Export-URL (1): Under the export URL, the generated feed is accessible and can be
queried by Instagram.

For details on this and how to integrate the data, please refer to the documentation on the Instagram 
https://business.instagram.com/tag-in

Template

https://www.facebook.com/business/instagram/shopping/guide


The template determines the structure of the product export file. The template is divided into a header line,
a product line and a footer line.
If you use a template in the General tab, usually no adjustments are necessary here. The correct document
templates for the respective comparison portals are already included in the templates. 
The Test template (1) button checks whether there are any syntax errors in the template. With
Generate preview (2) you can directly view the content of the created export file.

More information about the templates you can find here.

Under Variables (3) you can see which data you can use for the template.

https://docs.shopware.com/en/shopware-6-en/Productcomparison#template


With a click on the arrow, you can see a dropdown with all available variables. There you can copy the
variable you want to the clipboard by clicking on the copy symbol again.

Referral-Code

In order for the statistics to be calculated, the Instagram sales channel template must contain the following
variable:

{{ socialShoppingSalesChannel.salesChannelId }}

This variable is automatically added to the standard template for new social shopping installations or
updates. However, if you have previously adapted the template yourself, you must manually add this
variable once and thereby extend the variable to the SEO URL, so that the following line is then created:

<g:link>{{ seoUrl('frontend.detail.page', {'productId': product.id}) }}?referralCode={{ socialShoppingSalesChannel.salesChannelId }}</g:link>

Google Shopping

In order for the domain of the Google Shopping sales channel to be verified, an HTML tag must be stored.
This file must be located in the public directory of the Shopware installation and be accessible on the web.
Instructions on how to create the HTML tag file and everything else can be found in the Google Merchant
Center.

The "Google Shopping" sales channel provides all information relevant to Google Shopping in an XML feed.

Configuration

Language selection (1): Here you select for which language you want to hear the configuration. It is not
necessary to maintain the settings in each language, because these settings are always inherited from the
main language, if no own settings are made in a language. However, it may be useful to select the
respective storefront sales channel domain for each language, for example, to direct customers to the
appropriate language.

In the tab General (2) you configure the export feed generated later. The tabs Statistics
(3), Unpublished products (4), Integration (5) and Template (6) will only be displayed after the basic
configuration has been made and the settings have been saved.

https://support.google.com/merchants/answer/176793?hl=en
https://support.google.com/merchants/answer/176793?hl=en


General

Name (7): Enter a name for the sales channel here. This is used, for example, in the
sales channel overview in the menu on the left side.

Active (8): Activate the generation of the feed. If the feed is not active, no further
generation takes place and it cannot be accessed through the URL.

Storefront sales channel (9): Select here which storefront should be used for the
integration. This storefront will be used to display or purchase the articles through
Google Shopping.

Storefront sales channel domain (10): Based on the selected storefront sales
channel you can choose the domain to be used. This is especially important if the
storefront is accessible through different domains or if different languages are used.

Currency (11): Here you define the currency in which the products should be displayed.
You can choose from the currencies that are available in the assigned storefront sales
channel.

Dynamic product group (12): By assigning a dynamic product group, you define
which products should be exported to the feed for Google Shopping. To learn how to
create a dynamic product group, please refer to the appropriate documentation.

Additional settings

https://docs.shopware.com/en/shopware-6-de/Catalogues/Dynamicproductgroups


Import variants as own products (1): With this setting you can determine whether
each variant of variant products is transferred to Google Shopping as an independent
product. Alternatively, a collective product is used, in which the general product
information is listed. However, information on the individual variants is not included.

Generation interval (2): Use this setting to define how often the feed should be
regenerated for export. If you select "Live", the feed is generated each time it is called
up. For production systems, we recommend using the scheduler for this purpose. More
information about the scheduler you can find here.

Generate by Scheduler (3): This option allows you to generate the feed by cron job at
a certain time. Please note that the feed is only generated when the generation interval
has expired.

Default Google Product Category ID (4): The Google Product Category ID
determines the category in which the products will be included on Google Shopping.
Please note that only purely numeric values can be used here. You can find more
information on this on the Google help page, which is also linked in the admin section at
the appropriate place. 

Time of last generation (5): Here, you can see when the export feed was last
generated. This also allows you to see if the generation by the scheduler is executed
correctly.

Options

Please note that the item options only becomes available after the sales channel has been created (saved
initially).

Delete sales channel (1): Here you can delete the sales channel within Shopware. It
may be necessary to make additional adjustments to Google Shopping.

Statistics

https://docs.shopware.com/en/shopware-6-en/tutorials-and-faq/message-queue-and-scheduled-tasks#scheduled-tasks
http://support.google.com/merchants/answer/6324436


With the statistics, you can view various key figures of your orders via Google Shopping. These are divided
into orders, customers and turnover. Each statistic can be limited to different time periods, such as the last
24 hours or the last 30 days, via an option in the upper right corner.

Without the respective variable for the referral code in the template, the statistics cannot be calculated.
You can find more information on this in the template section.

Unpublished products

Please note that the unpublished products tab is only available after you have set up and saved the
general configuration.

Validate products (1): You can validate products at this point.

Result of the validation (2): After the validation has been carried out, you can see here whether
the products are transferd complete. If the validation should determine that products are not valid,
the corresponding products are listed here. In this case you should then check whether any data is
missing or whether the existing data is invalid (e.g. due to characters that cannot be displayed
correctly).

https://docs.shopware.com/en/shopware-6-en/extensions/social-shopping#template-2


Integration

In the tab Integration you will find further information on how to integrate the feed into Google.

Please note that the integration tab is only available after you have set up and saved the general
configuration.

Export-URL (1): Under the export URL, the generated feed is accessible and can be
queried by Google Shopping.

How you can add items to Google Shopping is explained in detail in the Google documentation
https://support.google.com/merchants/topic/7294771?hl=de&ref_topic=7259125

Template

https://support.google.com/merchants/topic/7294771?hl=de&ref_topic=7259125


The template determines the structure of the product export file. The template is divided into a header line,
a product line and a footer line.
If you use a template in the General tab, usually no adjustments are necessary here. The correct document
templates for the respective comparison portals are already included in the templates. 
The Test template (1) button checks whether there are any syntax errors in the template. With
Generate preview (2) you can directly view the content of the created export file.

More information about the templates you can find here.

Under Variables (3) you can see which data you can use for the template.

With a click on the arrow, you can see a dropdown with all available variables. There you can copy the
variable you want to the clipboard by clicking on the copy symbol again.

Referral-Code

In order for the statistics to be calculated, the Google Shopping sales channel template must contain the
following variable:

{{ socialShoppingSalesChannel.salesChannelId }}

This variable is automatically added to the standard template for new social shopping installations or
updates. However, if you have previously adapted the template yourself, you must manually add this
variable once and thereby extend the variable to the SEO URL, so that the following line is then created:

<link>{{ seoUrl('frontend.detail.page', {'productId': product.id}) }}?referralCode={{ socialShoppingSalesChannel.salesChannelId }}</link>

https://docs.shopware.com/en/shopware-6-en/Productcomparison#template


Pinterest

Pinterest is not integrated through export feeds. Meta data is used here, through which Pinterest can
retrieve the required information.

Configuration

Language selection (1): Here you define for which language you want to setup the configuration. It is not
necessary to maintain the settings in each language, because these settings are always inherited from the
main language, if no own settings are made in a language. However, it may be useful to select the
respective storefront sales channel domain for each language, for example, to direct customers to the
appropriate language.

In the tab General (2) you can configure the export feed generated later. The tabs Statistics (3) and 
Intergration (4) will only be displayed after the basic configuration has been completed and the settings
have been saved.

General

Name (5): Enter a name for the sales channel here. This is used, for example, in the
sales channel overview in the menu on the left side.

Active (6): Activate the generation of the feed. If the feed is not active, no further
generation takes place and it cannot be accessed through the URL.

Storefront sales channel (7): Select here which storefront should be used for the
integration. This storefront will be used to display or purchase the articles through
Facebook.

Storefront sales channel domain (8): Based on the selected storefront sales channel
you can choose the domain to be used. This is especially important if the storefront is



accessible through different domains or if different languages are used.

Currency (9): Here you define the currency in which the products should be displayed.
You can choose from the currencies that are available in the assigned storefront sales
channel.

*Options
Please note that the item options only becomes available after the sales channel has been created (saved
initially).

Delete sales channel (6): Here you can delete the sales channel within Shopware. It
may be necessary to make additional adjustments to Pinterest.

Integration

In the tab Integration, you will find some basic information on how the integration in Pinterest works. There
is also a button for validation. This button opens the Rich Pins Validator page on Pinterest. To view the
page, you may need to log in to Pinterest. This validator then checks whether all data relevant to Pinterest
can be called up. You can find more information about the Rich Pins in the documentation of Pinterest.

Please note that the integration tab is only available after you have set up and saved the general
configuration.

Customise default templates

The templates of the Social Shopping sales channels use a standard template. However, it could happen
that your products require further details or you simply want to add information. The template language
TWIG allows you to customise the template according to your wishes. Code snippets for frequently
requested additions can be found here.

https://developers.pinterest.com/docs/rich-pins/overview/
https://docs.shopware.com/en/shopware-6-en/tutorials-und-faq/howto/product-comparison-code-snippets


Want to dive deeper?
You’ll find an interactive learning path on this topic in the Community Hub. Explore it step by step, try out
features directly, and grow your knowledge in a playful, hands-on way. 

Sales channel

The sales channels offer you the possibility to connect different sales channels via a shop system. This can
be the classic storefront on the one hand. But it is also possible to transfer data to comparison portals (e.g.
billiger.de or Google Shopping) or to integrate social shopping (e.g. Instagram).

Overview

In the menu of the Shopware Administration you will find the item Sales Channel. You can click on the 
plus symbol to create a new sales channel. Already created sales channels are displayed below the point
Sales Channels and can be edited by clicking on them.

Customer assignment

In the settings under Shop > Log-in/sign-up > Bind customers to Sales Channel you have the
possibility to bind your customers to your sales channel.

If this option is activated, your customers can only log in to the sales channels in which they have
registered. This also applies if the option should be deactivated later.

If the option Bind customers to Sales Channel is disabled, all customers who register now will be able to
log in to all sales channels, even if the option is enabled later.

https://hub.shopware.com/learn/unit/user-social-commerce
https://docs.shopware.com/en/shopware-6-en/Productcomparison
https://docs.shopware.com/en/shopware-6-en/plugins/social-shopping


If a customer registers with the same e-mail address in two different sales channels with the option
activated, they will be treated as two different customers. The customer exists twice in your system, but for
different sales channels.

In your administration under Customers > Overview you can display the column for the sales channel via
the list settings.

To do this, first open the list settings (1) and then activate the option for the sales channel (2).

Then the column Sales channel will appear, in which you can see for which sales channel your customer
has registered.

Add a sales channel

To create a new sales channel, click the plus symbol next to the menu point Sales Channel.



In the pop-up window, you can choose whether you want to create a new Sales Channel with HTML
storefront or a headless sales channel that only provides an API interface. You can also create a
product comparison here. This is used to export your products to comparison portals and marketplaces.
Further information about this function is available here.

General settings

Name (1): This is the name of the sales channel. It is used internally at all places where
you can store settings for this sales channel.

Mark Sales Channel as favourite (2): Activating this option will cause this sales
channel to be displayed in the admin in the left sidebar under sales channels.

https://docs.shopware.com/en/shopware-6-en/Productcomparison


Entry point main navigation (3): This is where the main navigation begins. In the
standard Responsive Theme, the main categories correspond to the level below the
category selected here.

Navigation levels (4): Enter the number of levels to be displayed below the currently
selected level in the main navigation. The maximum possible number of levels depends
on the theme used.

Entry point footer navigation (5): Enter the start category for the Footer Navigation
here. In the Standard Responsive Theme, the level below this selected category contains
the footer navigation items and the level below contains the clickable menu items.

Entry point service navigation (6): Here you specify the level at which the Service
Navigation should start. In the standard Responsive Theme this category is displayed in
the bottom right.

Customer group (7): Enter the standard customer group of your sales channel here.
New customers and unannounced visitors are assigned to this customer group.

Countries (8): Indicate which countries should be available in your sales channel and
select a default country.

Languages (9): Indicate here which languages should be available in your sales
channel and select a default language.

Standard units of measurement (10): Enter the standard units (Default unit system,
Default length unit, Default weight unit) for your sales channel here.

Payment and shipping

Payment methods (1): Specify here which payment methods should be available in
your sales channel and select a default payment method. You can edit the available
payment methods under Settings > Payment methods.

https://docs.shopware.com/en/shopware-6-en/catalogues/categories
https://docs.shopware.com/en/shopware-6-en/catalogues/categories
https://docs.shopware.com/en/shopware-6-en/catalogues/categories
https://docs.shopware.com/en/shopware-6-en/settings/Paymentmethods


Shipping methods (2): Specify here which shipping methods should be available in
your sales channel and choose a default shipping method. You can edit the available
shipping methods under Settings > Shipping methods.

Currencies (3): Specify which currencies should be available in your sales channel and
select a default currency. You can edit the available currencies under Settings >
currencies.

Tax calculation (4): Establish how taxes should be calculated for orders in this sales
channel.
You can find an example illustrating the different calculations in our tutorial: Calculation
of the shopping cart

Hreflang

The Hreflang metatag is important if there are several language versions of your shop. The tag is used to
clearly assign the content to the respective language. It prevents Google from classifying multiple language
versions of your shop as duplicate content.

After you have activated the option, all your domains are displayed in the drop-down menu. Then select the
default domain here, which will serve as a fallback for all languages.

Domains

Please note that a self-hosted version differs from a cloud version in the domain settings.

Self-hosted instance

Under the item Domain you can create several domains for your sales channel, each with its own virtual
URL, language, currency, snippet set and its own unit system.
This is necessary if way you can create multiple language shops for one shop.

https://docs.shopware.com/en/shopware-6-en/settings/shipping
https://docs.shopware.com/en/shopware-6-en/settings/currencies
https://docs.shopware.com/en/shopware-6-en/settings/currencies
https://docs.shopware.com/en/shopware-6-en/tutorials-and-faq/Calculation-of-the-shopping-cart#calculation-examples
https://docs.shopware.com/en/shopware-6-en/tutorials-and-faq/Calculation-of-the-shopping-cart#calculation-examples


You can open the window for creating an additional URL by clicking the button Add Domain (1).

It is recommended that the domain be deposited with only one internet communication protocol (https:// or
http://), otherwise duplicate content may be created.

Cloud Instance

In a cloud instance, a URL is already stored in the standard system. This is generated automatically when
the instance is created.
If you want to use your own, individual domain, you can do this by clicking the button Add domain (1).
The prerequisite for this is that you have already added your own domain under Settings > System >
Domains. Alternatively, you can reach the corresponding menu by clicking on the link Set up individual
domain (2).

Information on how to set up your own domain can be found here

A server-side forwarding ensures that the connection is always established via https://.

In order to assign a domain to the sales channel, it is necessary to define some settings:

https://docs.shopware.com/en/shopware-6-en/saas/domains


URL: In the text field for the URL (1), enter the desired domain and any subdomain. By
clicking on https (encrypted) you can change the protocol to http (unencrypted).

Language: Specify the Language (2) in which the store should be accessed via this
URL. At this point, you can choose from all the languages that were assigned to the sales
channel in the basic settings above.

Currency: Define which Currency (3) should be used when accessing the store via this
URL. You can choose from the currencies available under Settings > Localisation >
Currencies.

Snippet: You use the Snippet (4) to specify which snippets are to be used. The
snippets available under Settings > Localisation > Snippets can be selected.

Hreflang localisation: Here you can define how the localisation (5) for the hreflang
attribute should take place. This allows you to transmit the correct translations to
Google, for example, when using multiple languages in your store. A distinction is made
here between localisation via the ISO standard or purely via the browser language used.
Localisation via ISO is useful, for example, if you use different (country-specific)
language variants that may use their own country-specific terms (e.g. in English or
French)

API access

Here you can generate an API Access ID for this sales channel. For more information on how to use your
own API accesses, please refer to our developer documentation.

Status

http://docs.shopware.com/en/shopware-platform-dev-en/api/sales-channel-api?category=shopware-platform-dev-en/api


Here you can temporarily disable the sales channel. It is then temporarily inaccessible for visitors and the
API. In addition you can activate the maintenance mode here. The frontend will then only display the
maintenance page layout. You can grant access using the whitelist for selected IP addresses.

Be mindful when using a proxy server

In order for the IP whitelisting to work correctly when using an additional proxy server, it is necessary to
store the IP address of the proxy in the .env configuration file (in the Shopware main directory) as
a trusted proxy. This is possible via the entry TRUSTED_PROXIES=IP_of_the_proxy".

Alternatively this is also possible using the PHP settings. More information on how to do this in PHP can be
found at https://symfony.com/doc/current/deployment/proxies.html#solution-settrustedproxies

Delete Sales Channel

If you delete the product comparison using this button, it will be irrevocably removed. You should only do
this if the sales channel is no longer needed.

The preinstalled Headless sales channel should never be deleted! Many extensions use this particular
iteration of a headless channel - among them our B2B-Suite.

If desired, you can hide the Headless channel in the Admin panel by setting one or more other sales
channels as favourites. All non-favourited sales channels will no longer be displayed then (Although they
can still be accessed via the dedicated Sales Channels menu).

Want to dive deeper?
You’ll find an interactive learning path on this topic in the Community Hub. Explore it step by step, try out
features directly, and grow your knowledge in a playful, hands-on way. 

Products

In the Products tab, you can assign products directly to the sales channel without having to edit each
product individually.

https://symfony.com/doc/current/deployment/proxies.html#solution-settrustedproxies
https://hub.shopware.com/learn/unit/user-sales-channels


Under Products you will first see an overview of all products that are already assigned to the sales channel.
You can use the search (1) to search for specific products in order to remove them. You can add further
products or entire product groups via the Add products button (2). On the left side (3) you can mark
one or more products to remove them from the sales channel. Using the context menu (4) on the right-
hand side, you can either remove the products or directly call up the product details of the respective
product. 

Add products



Product selection (1): All products that have not yet been assigned to the sales
channel are displayed here. You can select all products to be added and then add them.

Category selection (2): Your category tree is displayed here. You can select complete
categories whose products are to be added to the sales channel.

Product group selection (3): All the dynamic product groups you have created are
displayed here. You can add previously defined product groups to the sales channel. 

Manage Sales Channels

You can use the Manage Sales Channels button to display all of your sales channels. Whether storefront,
marketplaces or social media.

You also have the option of defining one or more sales channels as your favorites (1). If you activate this
option, the sales channel will automatically be displayed on the left in the sidebar (2) and those that are
not favorites are not displayed. This allows you to customize your menu in the sidebar and access it even
faster.



Theme

In the Theme tab you can assign a theme to your sales channel.

First of all you will see the theme that is currently assigned to the sales channel. If you click on the preview
image of the theme or on Change theme, you can assign one of the installed themes. Click on Edit
themes to go directly to the theme configuration.

Analytics

When using Analytics, Universal Analytics (discontinued by Google on 01 July 2023) or Google Analytics 4
can be used. 

Events

Analytics tracks the following interactions and events in the shop as standard:

add-to-cart.event.js

add-to-cart-by-number.event.js

begin-checkout.event.js

begin-checkout-on-cart.event.js

checkout-progress.event.js

login.event.js

purchase.event.js

remove-from-cart.event.js

search-ajax.event.js

sign-up.event.js

view-item.event.js

view-item-list.event.js


